# Contents

## PART 1  Introduction  

**Chapter 1 • Overview of SAS Clinical Data Integration**  
- What is SAS Clinical Data Integration?  
- Typical Workflow in SAS Clinical Data Integration  
- Recommended Reading

## PART 2  Information for Clinical Administrators  

**Chapter 2 • Administering Data Standards**  
- About Data Standards Administration  
- Importing Data Standards Metadata  
- Customizing Data Standard Properties  
- Customizing Data Standard Domain Templates  
- Managing Controlled Terminology  
- Managing Data Standard Compliance Checks  
- Analyzing Domain Use and Promoting a Custom Domain

**Chapter 3 • Working with Reports**  
- About Reports  
- Run and Save a Report

## PART 3  Information for Trial Managers  

**Chapter 4 • Managing Studies and Submissions**  
- About Managing Studies and Submissions  
- Working with Default Folders  
- Working with Default Libraries  
- Creating a Study or Submission  
- Manage Studies and Submissions  
- Monitoring the Statuses of Domains  
- Comparing the Metadata of a Standard Domain to Its Template

## PART 4  Information for Clinical Programmers or Data Managers  

**Chapter 5 • Working with Domain Data and Metadata**  
- Creating a Domain  
- Edit Domain Properties  
- Add Domain Columns or Edit Domain Columns Properties  
- Loading Data into Domains  
- Assessing CDISC SDTM Compliance
<table>
<thead>
<tr>
<th>PART 5</th>
<th>SAS® Integration Adapter for Medidata Rave</th>
<th>83</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 6 • General Administration</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td>Define a Medidata Rave Server</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td>Enable a SAS Clinical Data Integration User to Log In to Medidata Rave</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td>Verify That the Medidata Rave Server Has Been Registered Properly</td>
<td>86</td>
<td></td>
</tr>
</tbody>
</table>

| Chapter 7 • Study Administration | 87 |
| Manage the Connection between a SAS Clinical Data Integration Study and a Medidata Rave Study | 88 |
| Create a SAS Clinical Data Integration Data Table Definition from Medidata Rave Metadata | 90 |
| Manage the Medidata Rave Properties of a SAS Clinical Data Integration Study | 92 |
| Managing the Codelist Table in a SAS Clinical Data Integration Study | 96 |
| Review the Medidata Rave Properties of a SAS Clinical Data Integration Data Table Definition | 99 |
| Retrieving Medidata Rave Study Data | 99 |
| Schedule a Job to Update Study Data from Medidata Rave | 103 |

<table>
<thead>
<tr>
<th>PART 6</th>
<th>Appendixes</th>
<th>105</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix 1 • Adding Users to the Clinical Administrator Group</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Appendix 2 • Repairing Clinical Objects</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>Appendix 3 • SAS Clinical Data Integration Icons</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>Appendix 4 • Publish to SAS Drug Development</td>
<td>113</td>
<td></td>
</tr>
<tr>
<td>Overview of Publish to SAS Drug Development Feature</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td>Requirements</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td>Installation and Configuration</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td>General Steps</td>
<td>116</td>
<td></td>
</tr>
<tr>
<td>SAS Drug Development Servers</td>
<td>117</td>
<td></td>
</tr>
<tr>
<td>Jobs</td>
<td>117</td>
<td></td>
</tr>
<tr>
<td>Transformations</td>
<td>118</td>
<td></td>
</tr>
<tr>
<td>Process Names</td>
<td>119</td>
<td></td>
</tr>
<tr>
<td>Paths</td>
<td>120</td>
<td></td>
</tr>
<tr>
<td>Input and Output Folders</td>
<td>122</td>
<td></td>
</tr>
<tr>
<td>WebDAV Options</td>
<td>122</td>
<td></td>
</tr>
<tr>
<td>Refining Process Parameters in the SAS Drug Development Process Editor</td>
<td>122</td>
<td></td>
</tr>
<tr>
<td>Publish a SAS Clinical Data Integration Job to SAS Drug Development</td>
<td>124</td>
<td></td>
</tr>
<tr>
<td>Open a Job in the SAS Drug Development Process Editor</td>
<td>127</td>
<td></td>
</tr>
</tbody>
</table>

Index | 129 |
Part 1

Introduction

Chapter 1
Overview of SAS Clinical Data Integration .......................... 3
Chapter 1
Overview of SAS Clinical Data Integration

What is SAS Clinical Data Integration?

SAS Clinical Data Integration supports the pharmaceutical-industry needs for transforming, managing, and verifying the creation of industry-mandated data standards such as those created by Clinical Data Interchange Standards Consortium (CDISC). SAS Clinical Data Integration relies on SAS Data Integration Studio to provide centralized metadata management using the SAS Metadata Server and the tools that it provides to visually transform data. SAS Clinical Data Integration enhances its usability by adding new metadata types, plug-ins, and wizards. These enhancements help you perform clinically oriented tasks such as importing data standards, creating studies and submissions, and adding specialized transformations for mapping clinical data into a standard data model. SAS Clinical Data Integration leverages the SAS Clinical Standards Toolkit to provide validation and conformance checking.

SAS Clinical Data Integration enables you to:

• improve the consistency of submissions and studies
• improve the long-term management and growth of data
• use data standards effectively
• use a centralized SAS Metadata Server
• use the powerful and user-friendly features of SAS Data Integration Studio to manage metadata, generate and execute SAS Clinical Standards Toolkit code, and visualize the results
Typical Workflow in SAS Clinical Data Integration

Overview

The features and functionality provided by SAS Clinical Data Integration enables the following workflow:
1. Import a data standard and controlled terminology.
2. Create studies and submissions.
3. Define domains.
4. Standardize and validate data.
5. Monitor the progress of the definition of clinical domains.
6. Analyze data standard use across studies and submissions.

Workflow Owners

Typically, different people own different tasks in the workflow. However, ownership can vary depending on the company, and a person might perform tasks in more than one capacity. The following user definitions explain the typical owners and their tasks in the workflow.

Clinical administrator
- defines and manages data standards. Analyzes how data standards are implemented by programmers. Data standards administrators can view trends about how a domain is used by programmers. These trends might identify a new column to add to a domain, or point to a custom domain that you should promote into the standards.

For tasks that are typically performed by clinical administrators, see Chapter 2, “Administering Data Standards,” on page 9.

Trial manager
- defines studies and submissions, defines authorization, and sets the defaults that programmers use when defining content. Setting defaults ensures that programmers use the correct version of the data standards.

For tasks that are typically performed by trial managers, see Chapter 4, “Managing Studies and Submissions,” on page 37.

Clinical programmer and data manager
- creates standard and custom domains, writes jobs to extract and transform data into domains, and writes jobs to validate compliance of domains to a data standard.

For tasks that are typically performed by clinical programmers or data managers, see Chapter 5, “Working with Domain Data and Metadata,” on page 53.

Recommended Reading

For the following documentation, see the SAS Customer Support Web site at http://support.sas.com.


Part 2

Information for Clinical Administrators

Chapter 2
Administering Data Standards ........................................... 9

Chapter 3
Working with Reports ...................................................... 33
About Data Standards Administration

SAS Clinical Data Integration enables you to centrally define and manage data standards. You can also analyze how data standards are implemented by programmers. For example, you can view trends about how a domain is used by programmers. These trends might identify a new column to add to a standard domain because programmers are often adding the column during conversion. These trends might point to frequently created custom domains that should be promoted into the standards.
Typical user tasks include:

- “Importing Data Standards Metadata” on page 10
- “Customizing Data Standard Properties” on page 14
- “Managing Controlled Terminology” on page 16
- “Managing Data Standard Compliance Checks” on page 21
- “Analyzing Domain Use and Promoting a Custom Domain” on page 29

Importing Data Standards Metadata

Overview

You define a study relative to a particular data standard, such as CDISC-SDTM or a data standard from your company, by importing the data standard from the SAS Clinical Standards Toolkit.

If you want to use a CDISC standard, import data standard metadata from the SAS Clinical Standards Toolkit. Importing the metadata enables you to update your environment with new releases of data standards from CDISC. CDISC data standards are provided with the SAS Clinical Standards Toolkit. For more information, see the SAS Clinical Standards Toolkit: User’s Guide.

After importing a data standard that supports domain templates, column groups, and validation data sets, these items are displayed in the Data Standards folder in the Clinical Administration tree. For example, if you select the CDISC-SDTM data standard type and version 3.1.2, the domain templates (SDTM domains), column groups (SDTM classes), and validation data sets (compliance checks) are displayed in a folder that you specify in the Import wizard.

By default, an imported data standard has a status of Inactive. This status enables you or a data standards administrator to review the template and make changes before releasing it for general use. When you or the data standards administrator is satisfied with the template, you can change its status to Active, which makes the template available for general use. For more information, see “Make a Data Standard Available for General Use” on page 13.

Note: You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix 1, “Adding Users to the Clinical Administrator Group,” on page 107.

Import Data Standards Metadata

To import data standards metadata, perform the following steps:

1. In the Clinical Administration tree, select Data Standards, right-click, and then select Import.

   The Import Wizard appears.
2. Select the metadata source, and then click **Next**.

3. If the Default Application Server page appears, select one of the application servers that are listed.

   The Default Application Server page appears only when the Import Wizard is used for the first time. If you are unsure about which application server to select, contact the SAS installation representative.

4. On the Select Data Standard Type page, select the data standard type, and then click **Next**.

   The Select Data Standard Version page appears.

5. Select the data standard version to use, and then click **Next**.

   The CDISC standards that are listed are in the form of the standard short name, followed by the standard version number. For example, for SDTM 3.1.2, SDTM is the standard short name, and 3.1.2 is the standard version number. Each standard listing might also include a revision number that indicates the SAS Clinical Standards Toolkit version from which the standard definition was taken (for example, SDTM 3.1.2 (Revision 1.4).

6. On the Define General Properties page, edit the default values.
   a. Enter the name and the optional description.

      *Note:* It is a best practice not to include spaces in the data standard name.

   b. (Optional) In the **Formal Name** field, enter a more descriptive name for the data standard.

   c. In the **Identifier** field, enter a text value to uniquely identify the data standard in metadata.

      A default value is provided. The value that you enter is verified as unique before you continue.

   d. Select a type.
The values in the list are set up by the SAS Clinical Data Integration system administrator. These values are important when using the data standards metadata in the SAS Clinical Standards Toolkit. If the required type is not in the list, you should contact the system administrator to add the type, especially if the data standard uses the SAS Clinical Standards Toolkit. For more information about adding types, see “Customizing Data Standard Properties” on page 14.

If the data standard does not use the SAS Clinical Standards Toolkit, you can select any value.

e. (Optional) Enter the version and vendor, and then click Next.

The Verify Domain Properties page appears.

7. (Optional) Edit the domain property values, and then click Next.

Note: Domain properties are an advanced feature in SAS Clinical Data Integration. If you are uncertain about what domain property values to select, accept all of the default values.

The Verify Domain Column Properties page appears.

8. (Optional) Edit the domain column property values, and then click Next.

9. (Optional) If the data standard supports validation, on the Validation Library page, select a library or create a library, and then click Next.

For more information about SAS libraries, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

Note:

- You must have appropriate permissions for the selected library. For more information about permissions, see SAS Management Console: Guide to Users and Permissions.

- The path for the selected library must exist.

- The library metadata object is created immediately. Even if you close the Import Model wizard, the library will remain.

10. (Optional) If the data standard supports a data model, on the Verify Column Groups page, perform the following steps:

a. Review the column groups that are defined in the data standard, and then click Next.

The Verify Column Groups page is refreshed with detailed information about the columns that are defined in the data standard.

b. Click Next again.

11. (Optional) On the Verify Domain Metadata page, review the domain templates that are defined in the data standard, and then click Next.

Note: This information is provided only as a reference. It enables you to review the metadata before storing it. You cannot make changes to this information. If you see problems in the metadata, contact whomever is responsible for registering the data standard in the SAS Clinical Standards Toolkit.

12. (Optional) On the Verify Domain Column Metadata page, review the columns that are defined in the data standard, and then click Next.

Note: This information is provided only as a reference. It enables you to review the metadata before storing it. You cannot make changes to this information. If you
see problems in the metadata, then contact whomever is responsible for registering the data standard in the SAS Clinical Standards Toolkit.

13. Review the summary, and then click **Finish**.

**Make a Data Standard Available for General Use**

To make a data standard available for general use, perform the following steps:

1. In the **Clinical Administration** tree, expand **Data Standards**.
2. Select the data standard, right-click, and then select **Properties**.

   The Data Standard Properties dialog box appears.

3. Click the **Properties** tab.

4. In the **Active** row, change **false** to **true**.
5. Click **OK**.

---

**Customizing Data Standard Properties**

**Overview**

SAS Clinical Data Integration provides a common property model. This model defines the properties about which metadata can be collected. These properties are derived from CDISC data standards, but they are implemented so that you can customize how they are used.

For example, if a data standard does not use a property, then you can disable that property. You can adjust or expand the allowable values for a property. You can add constraints around the content, such as the minimum and maximum values, the length, and the default value.

For CDISC data standards, SAS Clinical Data Integration loads all of the CDISC information for you based on the SAS interpretation of the data standard. However, interpretations can vary, and you have the flexibility to apply your own interpretation.

Property values are inherited by newly created instances of the data standard template.

*Note:* You must have appropriate permissions to view the **Clinical Administration** tree. For more information, see Appendix 1, “Adding Users to the Clinical Administrator Group,” on page 107.

**View and Edit the Property Model of Studies and Submissions**

To view and edit the property model of studies and submissions, perform the following steps:

1. In the **Clinical Administration** tree, select **Study** or **Submission**, right-click, and then select **Edit Property Model**.

   The Edit Property Model Defaults dialog box appears.
2. Select a property in the Properties list. The associated values are displayed to the right of the list. If Use Lookups is selected, values are displayed in the Lookup Value list.

3. Specify the label and the minimum and maximum length.

4. (Optional) Enter or select the default value.

5. To specify the values for a property that uses lookup values, select the Use Lookups check box. Then, perform any of the following steps:
   • To add a value, enter the value in the Lookup Value field, and then click Save.
   • To clear text in the Lookup Value field, click New.
   • To delete a value, select a value from the list under Lookup Value, and then click Delete.
   • To edit a value, select a value from the list under Lookup Value, edit the value in the Lookup Value field, and then click Save.
   • To enable users to enter a value that is not in the list, select the Lookups are Customizable check box.
     You can then specify the minimum and maximum length.

6. Click OK.
Customizing Data Standard Domain Templates

Overview

You can make changes to the domain templates for the data standard by customizing domain clinical properties and domain column clinical properties.

To customize domain template metadata, see “Edit Domain Properties” on page 60.

To customize domain template column metadata, see “Add Domain Columns or Edit Domain Columns Properties” on page 61.

Managing Controlled Terminology

Overview

SAS Clinical Data Integration enables you to manage controlled terminology. Controlled terminology is a set of possible values for something. For example, controlled terminology for the valid values of yes and no could be expressed as (1-Yes, 2-No).

A terminology table is a SAS data set that contains controlled terminology data. SAS Clinical Standards Toolkit provides CDISC terminology tables.

A terminology package is a group of terminology tables. The data standards administrator creates terminology packages. The data standards administrator manages the granularity of the terminology and the groups to which the terminologies are available. For example, the following is the granularity of the terminology and the group to which it is available:

• a study or submission
• the transformations that use the controlled terminology

When a new study or submission is created, the trial manager selects the terminology package to use for the study or submission. This information is used by the CDISC-SDTM compliance transformation and the SDTM to CRT-DDS transformation.

If multiple terminology data sets are specified for a study or submission, changing the order of the terminology data sets affects the order in which the terminology tables are applied during a transformation. If a controlled term is defined several times, the first value found is the value used.

Importing Terminology Packages

To manage controlled terminology, you import CDISC terminology packages from SAS Clinical Standards Toolkit.

After a terminology package is imported, you can verify that the import was successful. You can open, delete, or rename the terminology tables using SAS Data Integration Studio. For more information, see SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.
You can create, rename, or change the order in which the terminology tables in the package are applied during a transformation. SAS Clinical Data Integration provides the following ways to manage terminology packages:

- “Import a Terminology Package from SAS Clinical Standards Toolkit” on page 17
- “Create a Terminology Package” on page 18
- “Edit a Terminology Package” on page 19

**Note:** You must have the appropriate permissions to import terminology packages. For more information, see Appendix 1, “Adding Users to the Clinical Administrator Group,” on page 107.

**Import a Terminology Package from SAS Clinical Standards Toolkit**

To import a terminology package from SAS Clinical Standards Toolkit, perform the following steps:

1. In the **Clinical Administration** tree, select **Data Standards**, right-click, and then select **Import**.
   
   The Import Wizard appears.

2. Select **Clinical Data Standards Toolkit**, and then click **Next**.
   
   The Select Data Standard Type page appears.

3. Select the data standard terminology package to import, and then click **Next**.
   
   The Select Data Standard Version page appears.

4. Select the data standard version to use, and then click **Next**.
   
   The Terminology Library page appears.

5. From the **SAS Library** drop-down list, select the library that contains the imported terminology table, or create a library.
For information about using the New Library Wizard, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

Note: The selected library must have the Create Metadata permission enabled.

6. Click Next

The Terminology Datasets Folder page appears.

7. On the Folders tab, select the metadata folder to contain the terminology metadata, and then click Next.

The summary page appears.

8. Click Finish.

Create a Terminology Package

To create a terminology package, perform the following steps:

1. In the Clinical Administration tree, select Controlled Terminology, right-click, and then select New Terminology Package.

The New Terminology Package wizard appears.

2. Enter a name for the new terminology package, an optional version number, and an optional description.

3. Click Next.

The Terminology Sets page appears.

4. To add a terminology set, perform the following steps:
   a. Click Add.

   The Add Terminology Sets wizard appears.
b. Select a SAS library or create a library, and then click **Next**.

   For information about creating a new library or editing a library, see the *SAS Data Integration Studio: User's Guide* or the SAS Data Integration Studio online Help.

   The Source Terminology Tables page appears.

   c. Select one or more tables in the library, and then click **Finish**.

5. To order the data sets, select a data set on the Terminology Sets page, and then click **Move Up** or **Move Down**.

6. Click **Finish**.

---

*Edit a Terminology Package*

To edit a terminology package, perform the following steps:

1. In the **Clinical Administration** tree, expand **Controlled Terminology**.

2. Select a terminology package, right-click, and then select **Properties**.

   The Controlled Terminology Properties dialog box appears.
3. Edit the properties.

4. To add a terminology set, perform the following steps:
   a. Click the **Properties** tab, and then click **Add**.

      The Add Terminology Sets wizard appears.

   b. Select a SAS library or create a library, and then click **Next**.
Managing Data Standard Compliance Checks

Overview

A set of compliance checks can be associated with each data standard. The data standards administrator can add new compliance checks and customize existing compliance checks for a data standard. Using these checks, you validate a clinical domain to determine whether it complies with the data standard. You perform validation by running a job that contains the CDISC-SDTM Compliance transformation.

The data standards administrator can customize validation for a data standard in the Manage Compliance Checks wizard. A compliance check can have an Active or Draft status. In the CDISC-SDTM Compliance transformation, where compliance checks are applied to clinical domains, non-administrator users can select and use only compliance checks that have an Active status. Only administrators can use compliance checks that have a Draft status. The Draft status enables administrators to set up and run compliance transformations to verify custom compliance checks. When an administrator is satisfied with the compliance check, the administrator changes the status to Active, and then the check is available to all clinical programmers.

Note: You must have the appropriate permissions to manage data standard compliance checks. For more information, see Appendix 1, “Adding Users to the Clinical Administrator Group,” on page 107.

See Also

- “View Compliance Checks” on page 23
- “Create or Edit a Compliance Check” on page 24
- “Change the Compliance Check Status” on page 28
- “Delete a Compliance Check” on page 29

Creating a Compliance Check

Overview

Note: To create a compliance check, you must be an advanced user who understands how validation works using the SAS Clinical Standards Toolkit. SAS Clinical Standards Toolkit is invoked by the SAS code that is generated from a compliance
transformation that uses validation. For more information about the SAS Clinical Standards Toolkit, see *SAS Clinical Standards Toolkit: User's Guide*.

The SAS Clinical Standards Toolkit provides a set of compliance checks for the data standards that support validation. SAS Clinical Data Integration imports these compliance checks when you import your data standards. You can create additional compliance checks and add them to the set.

The syntax for the following settings is determined by SAS Clinical Standards Toolkit:

- Domain and domain column specifications
- Code source
- Terminology lookup and reporting

For task information, see “Create or Edit a Compliance Check” on page 24.

**Domain Specification String and Column Specification String Values Requirements**

A value for the domain specification string and column specification string must meet the following requirements:

- Brackets must be matched.
- Valid characters are letters (A-Z and a-z), digits (0 to 9), or the underscore (_).
- The **_ALL_** syntax specifier cannot be used.
- The maximum length is 200 characters.

**Check ID Value Requirements**

A value for a check ID must meet the following requirements:

- The value must contain at least one non-whitespace character.
- All characters, except single and double quotation marks, are valid.
- The maximum length is eight characters.
- The value must be unique among all check IDs for any compliance check belonging to that data standard.

**Check Type Value Requirements**

A value for the check type must meet the following requirements:

- The value must contain at least one non-whitespace character.
- All characters, except single and double quotation marks, are valid.
- The maximum length is 20 characters.

**Severity Value Requirements**

A value for the severity must meet the following requirements:

- The value must contain at least one non-whitespace character.
- All characters, except single and double quotation marks, are valid.
- The maximum length is 40 characters.

**Error Message Value Requirements**

A value for the error message must meet the following requirements:
• The value must contain at least one non-whitespace character.
• All characters, except single and double quotation marks, are valid.
• The maximum length is 500 characters.

**Description Value Requirements**
A value for the description must meet the following requirements:
• The value must contain at least one non-whitespace character.
• All characters are valid. However, single and double quotation marks cannot be used together in the description. Use only single quotation marks or only double quotation marks.
• The maximum length is 500 characters.

**Code Source Value Requirements**
A value for the code source must meet the following requirements:
• The value must contain at least one non-whitespace character.
• All characters, except single and double quotation marks, are valid.
• The maximum length is 32 characters.

**Code Value Requirements**
A value for the code must meet the following requirements:
• All characters are valid. However, single and double quotation marks cannot be used together in the description. Use only single quotation marks or only double quotation marks.
• The maximum length is 2000 characters.

**Lookup Type and Lookup Source Value Requirements**
A value for the lookup type and lookup source must meet the following requirements:
• The value must contain at least one non-whitespace character.
• All characters, except single and double quotation marks, are valid.
• The maximum length for a lookup type is 20 characters.
• The maximum length for a lookup source is 32 characters.

**View Compliance Checks**
To view compliance checks, perform the following steps:
1. In the Clinical Administration tree, expand Data Standards.
2. Select a data standard, right-click, and then select Manage Compliance Checks.
   The Manage Compliance Checks wizard appears.
Note: If the data standard does not support compliance checking, or it does not have a compliance check installed, then a message appears.

3. To view only the Check ID and Description columns, clear the Show details check box.

   By default, the Available checks table displays details for each compliance check.

   Note: You can sort the table by clicking on any column heading.

4. Click Close.

**Create or Edit a Compliance Check**

**Start the Wizard**

For conceptual information, see “Creating a Compliance Check” on page 21.

Note: If the Next and Finish buttons are dimmed on a page in the wizard, one or more of the values on the page are not valid, or a required value is missing. Review the requirements for each value, and make corrections as needed.

To start to create or edit a compliance check, perform the following steps:

1. View the compliance checks.

   For more information, see “View Compliance Checks” on page 23.

2. To create a compliance check, right-click a compliance check, and then select Customize.

   The Customize Compliance Check wizard appears.
3. To edit a compliance check, perform the following steps:
   a. Right-click a compliance check, and then select **Make Draft**.
      To edit a compliance check, it must have a status of Draft.
   b. Right-click the compliance check, and then select **Edit**.
      The Edit Compliance Check wizard appears.
Specify the Check Properties Values
To specify the check properties values, perform the following steps:

1. On the Check Properties page, edit the values by performing the following steps:
   a. If you are creating a compliance check, enter a check ID.
      The value must meet the requirements; see “Check ID Value Requirements” on page 22.
   b. Select or enter a check type.
      The value must meet the requirements; see “Check Type Value Requirements” on page 22.
   c. Select or enter a severity.
      The value must meet the requirements; see “Severity Value Requirements” on page 22.
   d. Enter a description.
      The value must meet the requirements; see “Description Value Requirements” on page 23.
   e. In the Initial Status list, the default is always Draft.
      Note: After you test this check using the compliance transformation, you can set the status to Active.

2. Click Next.
   The Domains page appears.
Specify the Domains
(Optional) To specify the domains, perform the following steps:

1. To enable the **Domain Specification** field for editing, and disable the **Domains Referenced** table, select the **Direct Edit (Advanced)** check box.

2. (Optional) In the **Domains Referenced** table, edit a row to adjust the values for the domain.

   *Note:* When creating a compliance check, the **Domains Referenced** table might not be displayed. The table’s appearance depends on the type of compliance check that you have selected.

   When editing a compliance check, the **Domains Referenced** table appears only when the domain specification for the compliance check includes one or more domain IDs or domain specifiers.

3. In the **Domain Specification** field, enter the full domain specification string that is passed to SAS Clinical Standards Toolkit.

   The value must meet the requirements; see “Domain Specification String and Column Specification String Values Requirements” on page 22.

4. Click **Next**.

   The Domain Columns page appears.

Specify the Domain Columns
(Optional) To specify the domain columns, perform the following steps:

1. To enable the **Column Specification** field for editing, and to disable the **Columns Referenced** table, select the **Direct Edit (Advanced)** check box.

2. (Optional) In the **Columns Referenced** table, edit a row to adjust the values for the column.

   *Note:* The **Columns Referenced** table appears only when the column specification includes one or more column IDs or column specifiers.

3. In the **Column Specification** field, enter the full column specification string that is passed to the SAS Clinical Standards Toolkit.

   The value must meet the requirements; see “Domain Specification String and Column Specification String Values Requirements” on page 22.

4. Click **Next**.

   The Check Code page appears.

Specify the Check Code Values
(Optional) To specify the check code values, perform the following steps:

1. To enable the **Code Source** drop-down list and the **Code** field for editing, select the **Direct Edit (Advanced)** check box.

2. (Required) In the **Code Source** list, select or enter a macro provided by the SAS Clinical Standards Toolkit.

   *Note:* The **Code Source** list appears only when the column specification includes one or more column IDs or column specifiers.
3. In the **Code** field, enter the code to pass to the SAS Clinical Standards Toolkit. SAS Clinical Data Integration does not validate the syntax in the code. However, it does validate that the value requirements are met. For more information, see “Code Value Requirements” on page 23.

*Note:* All code must be consistent with the selected code source. And, the code must be valid SAS code.

4. Click **Next**.

If a terminology lookup is included in the compliance check, the Controlled Terminology Lookup page appears. Otherwise, the Reporting Options page appears.

**Specify the Controlled Terminology Lookup Values**

(Optional) If a terminology lookup is included in the compliance check, specify the values by performing the following steps:

1. To enable the **Lookup Type** and **Lookup Source** drop-down lists for editing, select the Direct Edit (Advanced) check box.

2. (Required) In the **Lookup Type** list, select or enter the type of terminology lookup.

   *Note:* SAS Clinical Data Integration does not validate whether the type exists.

3. (Required) In the **Lookup Source** list, you can select or enter the source of the terminology lookup.

   *Note:* SAS Clinical Data Integration does not validate whether the source exists.

4. Click **Next**.

The Reporting Options page appears.

**Specify the Reporting Options Values**

(Optional) To specify the reporting options, perform the following steps:

1. To enable the **Error Message** field, select the Direct Edit (Advanced) check box.

2. To specify that all violations for the compliance check are reported every time the validation is run, select the **Report All Violations** check box.

   If you clear this check box, only the first violation is reported.

3. In the **Error Message** field, enter the text to write to the data set when a violation is detected.

   You can use substitution variables in this field.

4. Click **Finish**.

**Change the Compliance Check Status**

To change the status of a compliance check, select one or more compliance checks, right-click, and then select either **Make Draft** or **Make Active**.
Delete a Compliance Check

To delete a compliance check, select one or more compliance checks, right-click the compliance check, and then select **Delete**.

The compliance check is deleted from the table and from persistent storage for the data standard.

Analyzing Domain Use and Promoting a Custom Domain

Overview

You can analyze how standard domains and custom domains are used in studies and submissions. With this usage information, you can identify custom domains that are used enough to become part of the data standard.

Typically, a custom domain is for use by a single study or submission. The custom domain is available only to the study or submission in which it is defined. When a custom domain becomes a standard domain (that is, when the custom domain is promoted to become part of the data standard), it can be included in any study or submission.

*Note:* You must have appropriate permissions to view the **Clinical Administration** tree. For more information, see *Appendix 1, “Adding Users to the Clinical Administrator Group,”* on page 107.

Analyze Domain Use and Promote a Custom Domain

To analyze domain use and promote a custom domain, perform the following steps:

1. In the **Clinical Administration** tree, expand **Data Standards**.
2. Select and right-click a data standard, and then select **Analyze Model Usage.**

The Analyze Model Usage dialog box appears.
The Studies/Submissions list displays all of the studies and submissions that currently use the selected data standard.

3. From the Studies/Submissions list, select one or more items.

4. To limit the domains to display, select a type from the Show domains of type dropdown list.

5. Click Show Domain Details.
   In the Domain Details list, a summary of the domains and domain columns appears. Each domain that is included in the selected study or submission appears as a column in the list.

6. To see the details of a domain, double-click the folder to expand the rows.
   Blue boxes specify the columns that are in each domain.
If the domain columns are identical across multiple studies or submissions, then you see the frequency in parentheses after the domain name. For domain columns that differ across studies or submissions, you see that each domain is listed separately.

7. To view with which study or submission a domain is associated, perform the following steps:
   a. Right-click the column heading, and then select **Display Domain Paths**.
      The Domain Paths dialog box appears.
   b. Review the domain paths, and then click **Close**.

8. To promote a custom domain, perform the following steps:
   a. Right-click the custom domain’s column heading, and then select **Promote**.
      A confirmation message appears.
   b. Click **Yes**.
      A new standard domain is created from the custom domain.

9. To verify that a standard domain was created from the custom domain, perform the following steps:
a. In the **Clinical Administration** tree, expand the selected data standard.

b. Expand **Domain Templates**.

   The new standard domain appears in this folder.
Chapter 3
Working with Reports

About Reports

You use the reports feature in SAS Data Integration Studio to generate SAS Clinical Data Integration reports. Clinical administrators can generate reports to show the following information:

• basic study information that is defined in the metadata
• basic submission information that is defined in the metadata
• standards that are defined in the metadata
• controlled terminology packages

Note: For detailed information about running reports and selecting options, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

Run and Save a Report

To run and save a SAS Clinical Data Integration report, perform the following steps:

1. Select Tools ⇒ Reports.

   The Reports dialog box appears.
2. In the Show field, select Clinical.

3. Select a SAS Clinical Data Integration report.

4. (Optional) Specify the path to the location in which to save the report by typing a location or by clicking Browse to navigate to a location.

   Note: It is a good idea to browse to examine the file folder hierarchy and to check the path. The folder must be on the server and must not be a local folder.

5. Enter the name.

6. Click the Run and view a report icon ( ].

   The report is run and saved.

   The Report View dialog box appears.

7. Choose whether to view the report.

   For more information about viewing a report, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

   Note: A report opens only if the Default Location field contains a valid path.
Part 3

Information for Trial Managers

Chapter 4
Managing Studies and Submissions ................. 37
## Chapter 4
Managing Studies and Submissions

### About Managing Studies and Submissions
SAS Clinical Data Integration studies and submissions are the top-level containers for all of the content and metadata created during the course of an entire study. A study

## Working with Default Folders

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>38</td>
</tr>
<tr>
<td>Folder Name Requirements</td>
<td>38</td>
</tr>
<tr>
<td>Folder and Library Descriptions Requirements</td>
<td>38</td>
</tr>
<tr>
<td>Library Name Requirements</td>
<td>39</td>
</tr>
<tr>
<td>libref Name Requirements</td>
<td>39</td>
</tr>
<tr>
<td>Add a Default Folder</td>
<td>39</td>
</tr>
<tr>
<td>View and Modify Default Folder Properties</td>
<td>39</td>
</tr>
<tr>
<td>Delete a Default Folder</td>
<td>40</td>
</tr>
</tbody>
</table>

## Working with Default Libraries

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>40</td>
</tr>
<tr>
<td>Add a Default Library</td>
<td>41</td>
</tr>
<tr>
<td>View and Modify Default Library Properties</td>
<td>41</td>
</tr>
<tr>
<td>Delete a Default Library</td>
<td>42</td>
</tr>
</tbody>
</table>

## Creating a Study or Submission

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>42</td>
</tr>
<tr>
<td>Folder Organization of Studies and Submissions</td>
<td>43</td>
</tr>
<tr>
<td>Name Requirements</td>
<td>43</td>
</tr>
<tr>
<td>Description Requirements</td>
<td>44</td>
</tr>
<tr>
<td>Create a Study or Submission</td>
<td>44</td>
</tr>
</tbody>
</table>

## Manage Studies and Submissions

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the Properties of a Study or Submission</td>
<td>45</td>
</tr>
<tr>
<td>Delete a Study or Submission</td>
<td>46</td>
</tr>
</tbody>
</table>

## Monitoring the Statuses of Domains

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>47</td>
</tr>
<tr>
<td>Monitor the Progress of a Study or Submission</td>
<td>47</td>
</tr>
</tbody>
</table>

## Comparing the Metadata of a Standard Domain to Its Template

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>48</td>
</tr>
<tr>
<td>Refresh the Metadata of a Standard Domain</td>
<td>48</td>
</tr>
</tbody>
</table>
contains study-level metadata and content. A submission contains aggregated metadata and content, or a collection of studies.

In SAS Clinical Data Integration, a trial manager can centrally define and manage study definitions, set up default content, and monitor the progress of the domain mapping process.

Before you create a study or submission, you can define the defaults for the study or submission. You can use default folders to maintain consistent metadata organization in a study and submission when it is created. You can use default libraries to maintain consistent use of SAS librefs. This consistency is necessary when you have standard programs and macros that are dependent on consistent SAS librefs.

For each study and submission, you can define one or more default data standards. When defining a data standard, remember that you are affecting the available data standard selections in all SAS Clinical Data Integration wizards within that study or submission. Only the data standards that you define as the defaults are displayed. These default settings ensure that you are always using the correct version of a data standard for a study or submission. After you create a study or submission, default content is created automatically.

Because all activities and relationships are stored in metadata, SAS Clinical Data Integration can produce a summary of the statuses of all activities for a selected study or submission. If you have multiple programmers working on the same submission or study, you can easily see what domains have been created, what domains are used in a mapping process, and whether a validation transformation is using a certain domain. If you are using change management, you can view who is working on the submission or study. For more information about change management, see *SAS Data Integration Studio: User’s Guide*.

---

### Working with Default Folders

#### Overview

SAS Clinical Data Integration enables you to define a metadata folder structure using default folders. This folder structure maintains consistent metadata organization when a study or submission is created.

You can customize which default folders are applied to a new study or submission. You can modify the default folder properties.

*Note:* You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix 1, “Adding Users to the Clinical Administrator Group,” on page 107.

#### Folder Name Requirements

A folder name must meet the following requirements:

- The maximum length is 60 characters.
- The name must not be the same as any existing folder name in the same parent folder. The comparison check is not case sensitive.
- The name cannot include whitespace characters.
Folder and Library Descriptions Requirements

The maximum length of a description for a folder or library is 200 characters.

Library Name Requirements

A library name must meet the following requirements:

- The maximum length is 60 characters.
- The name must not be the same as any existing default library name in the study or submission. The comparison check is not case sensitive.

libref Name Requirements

A libref name must meet the following criteria:

- The first character must be an alphabetic character or an underscore.
- Each subsequent character must be an alphabetic character, integer, or an underscore.
- The maximum length is eight characters.
- The name must not be the same as any existing default library name in the study or submission. The comparison check is not case sensitive.

Add a Default Folder

To add a folder to the default folder structure for a study or submission, perform the following steps:

1. In the Clinical Administration tree, expand Study or Submission.
2. Expand Default Content, right-click Root Folder, and then select New Subfolder. A new, untitled folder is created and displayed.
3. Enter a name for the folder, and then press ENTER.
   The name must meet the requirements; see “Folder Name Requirements” on page 38.

View and Modify Default Folder Properties

To view and modify default folder properties, perform the following steps:

1. In the Clinical Administration tree, expand Study or Submission.
2. Expand Default Content, and then expand Root Folder. The available default folders appear.
3. Select a default folder, right-click, and then select Properties. The Default Folder Properties dialog box appears.
4. Enter the name of the folder, and then enter an optional description.
5. Click **OK**.

**Delete a Default Folder**

To delete a default folder, perform the following steps:

1. In the **Clinical Administration** tree, expand **Study** or **Submission**.
2. Expand **Default Content**, and then expand **Root Folder**.
3. Select a default folder, right-click, and then select **Delete**.
   The folder and its subfolders are deleted.

---

**Working with Default Libraries**

**Overview**

SAS Clinical Data Integration enables you to define libraries to use in studies or submissions. It also enables you to edit the library properties. This consistency is necessary when you have standard programs and macros that are dependent on consistent SAS librefs.

*Note:* You must have appropriate permissions to view the **Clinical Administration** tree. For more information, see Appendix 1, “Adding Users to the Clinical Administrator Group,” on page 107.
Add a Default Library

To add a library as a default library, perform the following steps:

1. In the **Clinical Administration** tree, expand **Study** or **Submission**.
2. Expand **Default Content**.
3. Select **Libraries**, right-click, and then select **New Default Library**.
   The New Default Library wizard appears.

   ![New Default Library Wizard](image)

4. Enter a name for the library and a name for the libref.
   The names must meet the requirements; see “Library Name Requirements” on page 39 and “libref Name Requirements” on page 39.

5. (Optional) Enter a description.
   The description must meet the requirements, see “Folder and Library Descriptions Requirements” on page 39.

6. Click **Finish**.
   The new default library appears in the **Libraries** folder.

View and Modify Default Library Properties

To view and modify default library properties, perform the following steps:

1. In the **Clinical Administration** tree, expand **Study** or **Submission**.
2. Expand **Default Content**, and then expand **Libraries**.
   The available default libraries are displayed.
3. Select a default library, right-click, and then select **Properties**.
The Default Library Properties window appears.

4. Enter a name for the library and a name for the libref.
The names must meet the requirements; see “Library Name Requirements” on page 39 and “libref Name Requirements” on page 39.

5. (Optional) Enter a description.
The description must meet the requirements, see “Folder and Library Descriptions Requirements” on page 39.

6. Click OK.

**Delete a Default Library**

To delete a default library, perform the following steps:

1. In the Clinical Administration tree, expand Study or Submission.
2. Expand Default Content, and then expand Libraries.
3. Select one or more libraries, right-click, and then select Delete.

**Creating a Study or Submission**

**Overview**

You create a study or submission by providing basic object metadata such as name, description, and content location in the metadata tree. Then, SAS Clinical Data Integration collects metadata about the item. For example, a study collects metadata such
as protocol title, indication, and phase. After metadata is collected, the versions of the data standards that can be used for the study or submission are defined.

Note: Only an administrator can set the default content for a study or submission. For more information, see Appendix 1, “Adding Users to the Clinical Administrator Group,” on page 107.

Folder Organization of Studies and Submissions

A study or submission can be located at the root of the hierarchy in the Folders tree (Study 1 and Submission 1 in the following figure) or within a general folder (Study 2 and Submission 2).

**Figure 4.1 Illustration of Basic Folder Hierarchy**

You can create more complex hierarchies based on the containment rules shown in the following table:

**Table 4.1 Folder Containment Rules**

<table>
<thead>
<tr>
<th>Container</th>
<th>Study</th>
<th>Submission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Study</td>
<td>not allowed</td>
<td>not allowed</td>
</tr>
<tr>
<td>Submission</td>
<td>allowed</td>
<td>not allowed</td>
</tr>
</tbody>
</table>

Using the containment rules, here is an example of a complex folder hierarchy:

**Figure 4.2 Illustration of Complex Folder Hierarchy**

Name Requirements

A study or submission name has a maximum length of 60 characters.
Description Requirements

A study or submission description has a maximum length of 200 characters.

Create a Study or Submission

To create a study or submission, perform the following steps:

1. In the Folders tree, right-click a folder, and then select New ⇒ Study or Submission.

   The New Study or New Submission wizard appears.

2. Enter a name and optional description.

   The name must meet the requirements; see “Name Requirements” on page 43. The description must meet the requirements; see “Description Requirements” on page 44.

3. To change the location of the study or submission, click Browse, and then select a new location.

   For information about the location of a study or submission, see “Folder Organization of Studies and Submissions” on page 43.

4. Click Next.

   The Data Standards Selection page appears.

5. (Optional) Select one or more data standards.

   All active data standards to which you have access are displayed.

6. Click Next.

   The Study Properties or Submission Properties page appears.

7. (Optional) Specify the property values.
The properties that appear on this page and their default values are predetermined by the administrator's configuration of the data standard’s property model.

*Note:* Do not use single quotation marks, double quotations marks, or hyphens in the property values fields.

8. Click **Next**.

   The Library Selection page appears.

9. (Optional) Select one or more libraries to associate with the study.

   The libraries that are available on this page are predetermined by the default content for a study or submission.

10. Click **Next**.

    The Controlled Terminology page appears.

11. (Optional) To select a controlled terminology package to associate with the study or submission, perform the following steps:

   a. Click **Add**.

      The Available Terminology Packages dialog box appears. The controlled terminology packages that are available, as predetermined by the administrator, are listed.

   b. Select a package, and then click **OK**.

12. To remove a selected controlled terminology package, click **Remove**.

13. If you are creating a study, click **Finish**.

14. If you are creating a submission, click **Next**.

    The Contributing Studies page appears.

15. (Optional) Select one or more studies to associate with the submission, and then click **Finish**.

    All studies to which you have access are displayed.

---

**Manage Studies and Submissions**

**Edit the Properties of a Study or Submission**

To edit the properties of a study or submission, perform the following steps:

1. In the **Clinical Administration** tree, expand **Study** or **Submission**.

2. Select the study or submission, right-click, and then select **Properties**.

   The Study Properties or the Submission Properties dialog box appears.
3. Select the tab that contains the information that you want to edit, edit the information, and then click **OK**.

   For more information about any tab except the **Study** tab, see the *SAS Data Integration Studio: User's Guide* or the SAS Data Integration Studio online Help. The **Study** tab displays read-only information.

### Delete a Study or Submission

To delete a study or submission, perform the following steps:

1. In the **Clinical Administration** tree, expand **Study** or **Submission**.
2. Expand **Instances**.
3. Right-click the study or submission, and then select **Delete**.
4. Click **OK** to confirm the deletion.
   
   The study or submission is deleted, but the associated folder and its contents are not.
5. To delete the contents of the associated folder, in the **Folders** tree, right-click the folder, and then select **Delete**.

   **Note:** If you do not have the correct permissions, you cannot delete a folder. You cannot delete the root folder of a study or submission in the **Folders** tree unless you have first deleted the item from the **Clinical Administration** tree.
Monitoring the Statuses of Domains

Overview

You can monitor the statuses of domains to determine the progress of mapping the source data. In addition, you can determine whether a domain has been validated for compliance with a data standard.

Note: You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix 1, “Adding Users to the Clinical Administrator Group,” on page 107.

Monitor the Progress of a Study or Submission

To monitor the progress of a study or submission, perform the following steps:

1. In the Clinical Administration tree, expand Study or Submission.
2. Expand Instances.
3. Select a study or submission, right-click, and then select Monitor Domain Status.

The Domain Status dialog box appears.

TheDomains table reports the following information:

- the name of the domain
- the ID of the domain
- the description of the domain
- whether the domain has mapping jobs defined (that is, the domain has a job where the domain is a target)
- whether the domain has compliance jobs defined (that is, the domain is selected to be validated)
- whether the domain is locked and by whom
Comparing the Metadata of a Standard Domain to Its Template

Overview

You can compare the metadata of a standard domain to its template and optionally refresh the metadata. When you compare the metadata, the standard domain is compared with the standard domain template from which it was created. Then, you can choose to refresh the standard domain properties from the domain template properties.

Note: You can refresh the metadata of a standard domain only if the domain was based on a standard domain template.

Consider the following points when selecting an item to refresh:

• If you select a column to be refreshed, all of its properties are refreshed.

• To refresh some properties of a column, expand the Columns node, and then select the check boxes for each property that you want to refresh.

• To update the standard domain metadata to match the standard domain template metadata, select the root node check box.

Note: You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix 1, “Adding Users to the Clinical Administrator Group,” on page 107.

Refresh the Metadata of a Standard Domain

To refresh the metadata of a selected standard domain, perform the following steps:

1. In the Folders tree, expand a folder, expand a study or submission, and then expand any subfolders to locate a standard domain.

2. Select a standard domain, right-click, and then select Refresh Domain.

3. If a message appears stating that the standard domain template from which the domain was created and the standard domain are identical, choose whether to continue or not.

4. In the Refresh Domain window, expand the nodes in either tree to view the differences.
5. (Optional) Click View Differences.
   Only the properties that are different from the domain template appear.

6. (Optional) In the Standard Domain Template tree, select the check box next to one or more items to refresh.

7. Click Apply Checked.
   If there are no remaining differences to apply, or if you chose to update the standard domain metadata to match the standard domain template metadata, then the Refresh Domain window changes to view-only mode.

8. Click Close.
Part 4

Information for Clinical Programmers or Data Managers

Chapter 5

Working with Domain Data and Metadata
Chapter 5
Working with Domain Data and Metadata

Creating a Domain .......................................................... 54
  Overview ................................................................. 54
  Standard Domain ...................................................... 54
  Custom Domain ......................................................... 54
  Create a Standard Domain ........................................... 55
  Create a Custom Domain .............................................. 56
  Create a Custom Domain from an Existing Domain ............ 58

Edit Domain Properties .................................................. 60

Add Domain Columns or Edit Domain Columns Properties .......... 61

Loading Data into Domains .............................................. 63
  Overview ................................................................. 63

Assessing CDISC SDTM Compliance .................................... 63
  Overview ................................................................. 63
  Assess CDISC SDTM Compliance .................................... 63

Transforming SDTM Domains in a define.xml File ................... 66
  Overview ................................................................. 66
  Register a New Document File ....................................... 66
  Transform SDTM Domains into a define.xml File .................. 67

Adding Information to the CRT-DDS define.xml File ................. 69
  Overview ................................................................. 69
  Save the Work Tables from a CDISC-SDTM to CRT-DDS Transformation ........................................ 69
  Include Computational Algorithm and Codelist Metadata in the CRT-DDS define.xml File ............................... 71
  Adding Annotated CRF and Value-Level Metadata to the CRT-DDS define.xml File ........................................... 72

Running the CDISC-SDTM to CRT-DDS Transformation on Saved Data .................................................. 75
  Overview ................................................................. 75
  Run the CDISC-SDTM to CRT-DDS Transformation .................. 76

Validating a CRT-DDS define.xml File ................................ 77
  Overview ................................................................. 77
  Register a New Document File ....................................... 77
  Validate a CRT-DDS define.xml File ................................ 77

Reporting on the Results of a Transformation ......................... 78
  Overview ................................................................. 78
  Run a Report ............................................................ 79

Generating Unique Sequence Numbers as an Identifier Variable 80
Creating a Domain

Overview

After you create a study or submission, you create domains within that study or submission. You can create a domain only in a folder that is the root folder of a study or submission, or in a subfolder within the root folder of a study or submission. The domain can be a standard domain or a custom domain.

Note: In a study folder, a domain that you create is marked with the SAS Clinical Data Integration icon. This icon helps you to distinguish domains from other non-clinical tables.

Standard Domain

A standard domain is created from a data standard that defines the domain template. When you create a standard domain, the new domain is a copy of the domain template that conforms to an existing data standard. You can use as many domain templates as you need. The domain templates that you use to create domains are copied into a folder. Associations in the domain template metadata associate the domain template copy in this folder to the data standard from which it originated. These associations enable you to customize the domain template copy without affecting the data standard. In addition, these associations enable you to validate the copy to determine whether any customizations in the copy do not conform to the data standard.

All standard domains within a folder must be associated with the same data standard. If you want to create a copy of the standard domain using a different version of the data standard, you must create the copy in a different folder. SAS Clinical Data Integration provides domain templates that conform to existing data standards.

After selecting the standard domain templates that you want to use, you can assign a library. The library is where the physical data is created when the job is run.

Custom Domain

During a study, there might not be an appropriate domain template for the domain that you want to create. In this case, you can create a custom domain. The custom domain uses the data model defined by the data standard to create the appropriate columns and metadata.

For example, SDTM defines a data model that is based on creating domains from groups of columns, specifically identifiers, interventions, events, findings, and timings. SAS Clinical Data Integration generalizes the concept of grouping columns with the term column group. A column group makes up a portion of a complete table.

Note: To create a custom domain, the data standard must have column groups.

The key criterion for creating a custom domain is whether it is meant to hold data for interventions, events, or findings. In SAS Clinical Data Integration, interventions, events, or findings are considered conditional column groups. You can select only one conditional column group per custom domain.
In addition to selecting a conditional column group, you must specify identifiers and timing. You must also select the individual columns that you want to include in the custom domain. Some column names must be prefixed with the identifier. If you select a column that has this requirement, SAS Clinical Data Integration automatically creates the correct column name with the prefix. You can define keys and set the column order before the domain is created.

You can also create a custom domain based on an existing domain. Select an existing domain that most closely satisfies your needs, duplicate it, and then modify it as needed.

**See Also**

- “Create a Standard Domain” on page 55
- “Create a Custom Domain” on page 56
- “Create a Custom Domain from an Existing Domain” on page 58
- “Add Domain Columns or Edit Domain Columns Properties” on page 61

**Create a Standard Domain**

To create a domain using a standard domain template, perform the following steps:

1. In the Folders tree, select a study or submission folder, right-click, and then select New ⇒ Standard Domain(s).

   The New Standard Domain(s) wizard appears.

   ![New Standard Domain(s) wizard](image)

2. To change the default location of the domain, click **Browse** and then select a new location.

   By default, the location is set to the folder that you selected in step 1.

3. Click **Next**.

   The Data Standard Selection page appears.
Create a Custom Domain

To create a custom domain, perform the following steps:

1. In the Folders tree, select a study or submission folder, right-click, and then select New ⇒ Custom Domain.

   The New Custom Domain wizard appears.
2. To change the default location of the domain, click **Browse**, and then select a new location.

   By default, the location is set to the folder that you selected in step 1.

3. Click **Next**.

   The Data Standard Selection page appears.

4. Select a data standard.

   The data standards in this list are associated with the study or submission in which the domain is to be created.

5. Click **Next**.

   The General Information page appears.

6. Enter a name and an identifier, and then click **Next**.

   **Note:** The name and identifier cannot be the same as the name or identifier of a domain template in the data model.

   The Domain Information page appears.

7. (Optional) Specify the property values for the new domain, and then click **Next**.

   The Library Selection page appears.

8. (Optional) Select a library to assign to the domain.

   The library can be any library in the study or submission. If no libraries exist within the study or submission root folder or within a subfolder of the study or submission root folder, a message appears.

   **Note:** You can create a domain without assigning a library. Later, you can create a library and assign it to the domain. However, if you use the domain in a job without first assigning a library, the job fails. The job generates errors that indicate you must assign a library. If you attempt to open the domain to view the contents and records, the open fails, and an error message appears.

9. Click **Next**.
The Column Group Selection page appears.

10. Select a conditional column group to use in the new domain.
   
   Column groups are groups of columns that are available to all new domains in a data standard. This page displays the core column groups that are available to all new domains in the data standard.
   
   Note: Column groups can differ depending on the selected data model.

11. Click Next.
    
    The Column Selection page appears.

12. Using Add and Remove, move columns between the list Available Columns and the Selected Columns list.
    
    You can add columns individually or as a group.

13. (Optional) To customize column properties, perform the following steps:
    a. Click Next.
       
       The Column Elaboration page appears.
    b. Edit the properties for selected columns.
       
       The Selected Columns table displays all of the selected columns and their properties. Not all properties can be edited. The properties vary by data model.
    c. (Optional) To change the column order, select a column, and then click Move Up or Move Down.
    d. (Optional) If two or more columns are keys, change the key order by clicking Order Keys.
       
       The Order Domain Keys window appears. Select a key, and then click Move Up or Move Down to adjust its order. Click OK to save the key order.

14. Click Finish.

Create a Custom Domain from an Existing Domain

CAUTION:
Use this process to create a custom domain instead of using the standard SAS Data Integration Studio copy-and-paste method. The copy-and-paste method does not copy important domain metadata.

To create a custom domain using an existing domain, perform the following steps:

1. In the Folders tree, select a study or submission folder, right-click, and then select New ⇒ Custom Domain From Existing.
   
   The New Custom Domain From Existing Domain wizard appears.
2. To change the default location of the domain, click **Browse**, and then select a new location.

   By default, the location is set to the folder that you selected in step 1.

3. Click **Next**.

   The Data Standard Selection page appears.

4. Select a data standard.

   The data standards in this list are associated with the study or submission in which the domain is to be created.

5. Click **Next**.

   The Domain Selection page appears.

6. Select a domain.

   The **Available Domains by Study/Submission** list displays the studies and submissions and their domains for the selected data standard. Expanding a study or submission node displays all of the domains in the study or submission. Both standard and custom domains can be selected.

7. Click **Next**.

   The General Information page appears.

8. Enter the name and identifier for the new domain, and then click **Next**.

   The Domain Information page appears.

   *Note:* The name and identifier cannot be the same as the name or identifier of a domain template in the data model.

9. Specify the property values for the new domain, and then click **Next**.

   The Library Selection page appears.

10. (Optional) Select a library to assign to the domain.
The library can be any library in the study or submission. If no libraries exist within the study or submission root folder or within a subfolder of the study or submission root folder, a message appears.

Note: You can create a domain without assigning a library. Later, you can create a library and assign it to the domain. However, if you use the domain in a job without first assigning a library, the job fails. The job generates errors that indicate you must assign a library. If you attempt to open the domain to view the contents and records, the open fails, and an error message appears.

11. Click **Next**.

The Column Elaboration page appears.

12. Specify the properties for selected columns.

   The **Selected Columns** table displays all of the selected columns and their properties. Not all properties can be edited. The properties vary by data model.

13. (Optional) To change the column order, select a column, and then click **Move Up** or **Move Down**.

14. (Optional) If two or more columns are keys, change the key order by clicking **Order Keys**.

   The Order Domain Keys window appears. Select a key, and then click **Move Up** or **Move Down** to adjust its order. Click **OK** to save the key order.

15. Click **Finish**.

---

### Edit Domain Properties

To edit domain properties, perform the following steps:

1. In the **Folders** tree, select a domain, right-click, and then select **Properties**.

   The Properties dialog box appears.

2. Select the tab that contains the information that you want to edit, and then edit the information.

   Note: Property values cannot contain double quotation marks.
For more information about any tab except the Clinical Domain tab, see the SAS Data Integration Studio: User’s Guide or the SAS Data Integration Studio online Help.

3. (Optional) To change properties for the domain, click the Clinical Domain tab.

The Properties table enables you to enter values and select values from lists, depending on the property definition.

Note:

- You might not be able to edit some property values.
- Ensure that the Archive Title clinical domain property has a value so that it appears in the define.xml file. For more information about updating properties, see “Edit Domain Properties” on page 60.

4. Click OK.

---

Add Domain Columns or Edit Domain Columns Properties

To add domain columns or edit domain columns properties, perform the following steps:

1. In the Folders tree, select a domain, right-click, and then select Properties.

   The Properties dialog box appears.

2. Click the Columns tab.

   The domain columns are listed.

3. (Optional) To add a domain column, perform the following steps:

   a. Click the New Column icon.

      A new entry appears as the last row of the Columns table.

   b. Enter a name and description for the column.
c. Edit the default column characteristics, if necessary.
d. Click **OK**, or edit the column’s properties.

4. (Optional) To edit a column’s properties, perform the following steps:

   a. Right-click a column, and then select **Properties**.

      The Column Properties dialog box appears.

      ![Column Properties dialog box](image)

      b. Select the tab that contains the information that you want to edit, and then edit the information.

      *Note:* Property values cannot contain double quotation marks.

      For more information about any tab except the **Clinical Column** tab, see the [SAS Data Integration Studio: User's Guide](#) or the SAS Data Integration Studio online Help.

   c. To change properties for the domain column, click the **Clinical Column** tab.

      The **Properties** tables enables you to enter text and select values from lists depending on the property definition.

      *Note:* You might not be able to edit some property values.

   d. (Optional) To specify that the column is automatically designated a key when a custom domain is created, select the value **true** for the **Contributes to Key** property.

   e. Click **OK** twice.
Loading Data into Domains

Overview

You load study data into a domain (convert the study data into CDISC SDTM target files) by creating a SAS Data Integration Studio job. The job that you create to load the data uses standard SAS Data Integration Studio functionality. The job does not require any functionality from SAS Clinical Data Integration.

For more information about creating a job, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

Assessing CDISC SDTM Compliance

Overview

You assess the structural and content compliance of a domain with a data standard (such as CDISC SDTM) by using the CDISC-SDTM Compliance transformation. You can assess an individual domain or a set of domains. The process assesses whether the selected domains comply with the data standard.

Note: For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

Assess CDISC SDTM Compliance

To assess CDISC SDTM compliance, perform the following steps:

1. Select **File** ⇒ **New** ⇒ **Job**.
   
   An empty job diagram appears on the Diagram page.

2. In the **Transformations** tree, expand **Clinical**, and then drag **CDISC-SDTM Compliance** onto the diagram.
   
   The Diagram tab displays the **CDISC-SDTM Compliance** transformation and the Results and Metrics work tables.
3. (Optional) To store the Results and Metrics work tables in a permanent location, perform the following steps:
   
   Note: By default, the work tables are written to a temporary work location.
   
a. Right-click each Work Table icon ( ), and then select Properties.
   
The Properties dialog box appears.
   
   For detailed information about the Properties dialog box, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.
   
b. Click the Physical Storage tab, select a SAS library for the Location field, and then click OK.

4. In the diagram, double-click CDISC-SDTM Compliance.
   
The CDISC-SDTM Compliance Properties dialog box appears.

5. Click the Data Standard tab.
   
   All active SDTM data standards are displayed.

6. Select a data standard, and then click the Domains tab.
   
The studies and submissions are displayed.

7. Expand a study or submission to view its domains.

8. Select the domains to validate, or select the study or submission to select all of its domains.
   
   Note: You can select domains from multiple studies and submissions.

9. Click the Checks tab.

10. If no compliance checks are displayed, perform the following steps:
    
a. Click Add.
    
    The Add Compliance Check(s) dialog box appears with a list of all available compliance checks.
b. Click **Show details**.

Detailed information about each compliance check appears.

*Note:* If you imported the CDISC SDTM 3.1.2 data standard, then compliance checks for this data standard also appear in the **Standard** column in the **Checks** tab. A check that has the value **CDISC-SDTM** applies to both the CDISC SDTM 3.1.1 and CDISC SDTM 3.1.2 standards. A check that has the value **CDISC-SDTM 3.1.2** applies to the CDISC SDTM 3.1.2 standard only.

c. Select one or more checks, click **Add Selected**, and then click **Close**.

*Note:* Some check IDs are listed more than once. When you select **Show details**, you can view information that makes the individual compliance check unique. For example, consider the check ID SDTM0001:

- In the first record, **Source** is **Janus** and **Severity** is **Note**. If the domain fails this compliance check, then the Results work table reports a note.
- In the second record, **Source** is **WebSDM** and **Severity** is **Warning**. If the domain fails this compliance check, then the Results work table reports a warning.

To be efficient, choose only a subset of the compliance checks. It is inefficient to run the same compliance checks multiple times if the only differences between the checks are severity and source.

11. Click **OK** to close the CDISC-SDTM Compliance Properties dialog box.

A green check mark next to the CDISC-SDTM Compliance transformation indicates that the transformation is complete.

*Note:* If you see a red X, hover over the transformation and review the error information that appears. A typical error is that selected domains do not have a library assigned. Correct any errors before running the job.

12. Click **Run**.
SAS Data Integration Studio generates the SAS code for validating the selected data standard model, and then submits the code to SAS. The Results and Metrics work tables are generated.

13. Review the Results work table to see the results of the compliance checks.

You might want to connect the Results and Metrics work tables as input to the code that will be used to generate formatted reports of the results.

*Note:* You might encounter errors or warnings in the SAS log during job execution. These errors or warnings do not mean that validation was unsuccessful. Most errors that halt a validation are reported in the Results work table. As a general rule, the Results work table reports failures and provides information about the cause of the failures. For more information about validation, see the *SAS Clinical Standards Toolkit: User Guide*.


For information, see “Reporting on the Results of a Transformation” on page 78.

---

**Transforming SDTM Domains in a define.xml File**

**Overview**

The CDISC-SDTM to CRT-DDS transformation transforms SDTM domains into a define.xml file. The define.xml file complies with the CRT-DDS standard.

*Note:* For detailed information about creating a job with a transformation, see the *SAS Data Integration Studio: User's Guide* or the SAS Data Integration Studio online Help.

**Register a New Document File**

Before you can create a job that uses a define.xml file, you must register a new document file. The document file references the target define.xml file.

*Note:* The target define.xml file is created on the server. If you want to open the target define.xml file from the job, then the target file must be in a shared location that can be accessed from the computer on which you are using SAS Data Integration Studio. An example of a shared location is a network drive.

To register a new document file, perform the following steps:

1. In the **Folders** tree, right-click a folder, and then select **New ⇒ Document**.

The New Document dialog box appears.
2. Enter a name and optional description.

3. (Optional) Click **Browse** adjacent to the **Location** field, and then navigate to the location in which to store the document.

4. Click **Browse** adjacent to the **File** field, and then navigate to the location of the define.xml file.

5. Click **OK**.

**Transform SDTM Domains into a define.xml File**

To transform SDTM domains into a define.xml file that complies with the CRT-DDS standard, perform the following steps:

1. Select **File** $\Rightarrow$ **New** $\Rightarrow$ **Job**.
   
   An empty job diagram appears on the Diagram page.

2. In the **Transformations** tree, expand **Clinical**, and then drag **CDISC-SDTM to CRT-DDS** onto the diagram.
3. Right-click **CDISC-SDTM to CRT-DDS**, and then select **Properties**.

The CDISC-SDTM to CRT-DDS Properties dialog box appears.

For detailed information about the Properties dialog box, see the *SAS Data Integration Studio: User's Guide* or the SAS Data Integration Studio online Help.

4. Click the **Domains** tab.

5. In the **Available Domains by Study/Submission** list, select one or more domains to include in the define.xml file.

6. (Optional) Click the **Generation** tab, and perform the following steps:
   a. In the **Header comment** field, enter the header comment text for the define.xml file.
   b. In the **Output encoding** field, select an encoding.
   c. In the **Output Stylesheet** area, select a style sheet to use.

   *Note:* By default, no output style sheet is used. You can use a default style sheet provided by SAS Clinical Standards Toolkit, or you can select your own style sheet.

7. Click **OK**.

8. From the **Folders** tree, drag the define.xml file onto the diagram.

9. To connect the CDISC-SDTM to CRT-DDS transformation to the define.xml file, drag the cursor from the output port of the transformation to the define.xml file.

10. To store CRT-DDS Results work table in a permanent location, perform the following steps:

   *Note:* By default, the CRT-DDS Results work table is written to a temporary work location.

   a. Right-click the Work Table icon ( ), and then select **Properties**.

   The Properties dialog box appears.

   For detailed information about the Properties dialog box, see the *SAS Data Integration Studio: User's Guide* or the SAS Data Integration Studio online Help.
b. Click the **Physical Storage** tab, select a SAS library for the **Location** field, and then click **OK**.

11. Save and run the job.

SAS Data Integration Studio generates the SAS code for transforming, and then submits the code to SAS. The CRT-DDS define.xml file is created. If a define.xml already exists in that location, then it is overwritten (if the permissions on the file allow it to be overwritten). The results are written to the CDISC-SDTM to CRT-DDS Results work table.

12. Review the Results work table, and check for errors or warnings.

You can view the define.xml file by navigating to the location where you created the document file, and then opening the define.xml file with a Web browser. If the Web browser fails to open the define.xml file, and displays an error message about an invalid path, then the define.xml file is located on a drive to which you do not have access. To resolve the problem, move the define.xml file.

13. (Optional) Report on the results of the transformation.

For information, see “Reporting on the Results of a Transformation” on page 78.

---

**Adding Information to the CRT-DDS define.xml File**

**Overview**

You can save the data from the CDISC-SDTM to CRT-DDS transformation so that you can edit the tables to add information to the CRT-DDS that is not represented in the SAS Clinical Data Integration metadata. The process involves the following tasks:

- **save the data from a CDISC-SDTM to CRT-DDS transformation**
  
  For information, see “Save the Work Tables from a CDISC-SDTM to CRT-DDS Transformation” on page 69.

- **include computational algorithm and codelist metadata in the CRT-DDS define.xml file**
  
  For information, see “Include Computational Algorithm and Codelist Metadata in the CRT-DDS define.xml File” on page 71.

- **add annotated CRF and value-level metadata to the CRT-DDS define.xml file**
  
  For information, see “Adding Annotated CRF and Value-Level Metadata to the CRT-DDS define.xml File” on page 72.

**Save the Work Tables from a CDISC-SDTM to CRT-DDS Transformation**

To save the work tables from a CDISC-SDTM to CRT-DDS transformation, perform the following steps:

1. Select File ➔ **New** ➔ **Job**.

   An empty job diagram appears on the Diagram page.
2. In the Transformations tree, expand Clinical, and then drag CDISC-SDTM to CRT-DDS onto the diagram.

For information about adding a CDISC-SDTM to CRT-DDS transformation, see “Transforming SDTM Domains in a define.xml File” on page 66.

3. Right-click CDISC-SDTM to CRT-DDS, and then select Properties.

   The CDISC-SDTM to CRT-DDS Properties dialog box appears.

   For detailed information about the Properties dialog box, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

4. Click the Generation tab.

5. Select the Save work tables to permanent location check box, and then click Browse that is adjacent to the Location field.

   The Select Path dialog box appears.

   Note: The file type is Folder. You can select entries that are folders.

6. Select a folder, and then click OK twice.

   Note: The folder must be accessible by the SAS Workspace Server where the code executes. This means that the folder that appears is not on your local computer, but is on the SAS Workspace Server. You must have Write access permission to this folder. If there are tables from a previous CDISC-SDTM to CRT-DDS transformation in this folder, they will be overwritten without any prompting.

   When creating a define.xml file, select a location into which tables that are created by the CDISC-SDTM to CRT-DDS transformation can be copied.

7. Save and run the job.

   SAS Data Integration Studio generates the SAS code for validating, and then submits the code to SAS. The CRT-DDS define.xml file is created. Several tables are created in the folder that you selected. Depending on the metadata found for the domain and study, many of these tables will be empty. For more information about the tables that are created, see the SAS Clinical Standards Toolkit: User's Guide.
Include Computational Algorithm and Codelist Metadata in the CRT-DDS define.xml File

Overview
You can include computational algorithm and codelist metadata about the domains that collected during a study. This study might have involved domains transformed from the CDISC-SDTM standard format to the CRT-DDS standard format. To do this, you need to edit the metadata properties for each domain column that has a codelist or computational algorithm, and then use the CDISC-SDTM to CRT-DDS transformation to transform CDISC SDTM domains into a define.xml file that meets the CRT-DDS standard.

Edit Clinical Properties
To edit clinical properties, perform the following steps:
1. In the Folders tree, right-click a domain, and then select Properties.
   The Properties dialog box appears.
   For detailed information about the Properties dialog box, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.
2. Click the Columns tab.
   The domain columns are listed.
3. Right-click a column, and then select Properties.
   The Properties dialog box appears.
   For detailed information about the Properties dialog box, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.
4. Click the Clinical Column tab.
5. In the Method property, enter the computational algorithm metadata.
6. In the XML Codelist property, enter the codelist metadata.
7. Click OK twice.
8. Add the CDISC-SDTM to CRT-DDS transformation to the job.
   For detailed information about adding a CDISC-SDTM to CRT-DDS transformation, see “Transforming SDTM Domains in a define.xml File” on page 66. Select the domains of the columns that you edited in the previous steps.
9. Run the job.
   The computational algorithm and codelist metadata will be included in the CRT-DDS define.xml file.
10. Open the define.xml file.
    Notice that the Codelist and Computational Method information appears for each of the domain columns where you updated the column properties.
Adding Annotated CRF and Value-Level Metadata to the CRT-DDS define.xml File

Overview
You can include the annotated Case Report Form (CRF) metadata and value-level metadata about the domains that you collected during a study. To do this, you edit the SAS data sets that were generated by the CDISC-SDTM to CRT-DDS transformation to include the metadata. Then, you run the %CRTDDS_WRITE macro to generate the CRT-DDS define.xml file.

Here is example code that includes annotated CRF metadata:

*Lookup OID for the SDTM 3.1.2 standard in MetaDataVersion;
proc sql noprint;
select OID into :mdv from _svWork.MetaDataVersion
where name="CDISC-SDTM 3.1.2";
quit;

*Add records for Annotated CRF;
proc sql;
insert into _svWork.AnnotatedCRFs
set DocumentRef = "BlankCRF",
leafID= "AnnotatedCRF",
FK_MetaDataVersion = "&mdv";
insert into _svWork.MDVLeaf
set ID= "AnnotatedCRF",
href = "./blankcrf.pdf",
FK_MetaDataVersion = "&mdv";
insert into _svWork.MDVLeafTitles
set title= "Blank Annotated CRF",
FK_MDVLeaf = "AnnotatedCRF";
quit;

*reassign srcdata to location of _svWork data sets;
data _null_; path=pathname('_svwork'); rc=libname('srcdata'); rc=libname('svrcdata',path);
run;

*create new define.xml file using updated SAS CRT-DDS data sets;
%crtdds_write(_cstCreateDisplayStyleSheet=1);

Here is example code that includes the value-level metadata in the SC domain. The code includes two values: height without shoes and weight without shoes.

*Lookup OID for the SDTM 3.1.2 standard in MetaDataVersion;
proc sql noprint;
select OID into :mdv from _svWork.MetaDataVersion
where name="CDISC-SDTM 3.1.2";
quit;

*Lookup OID for the SCTEST column in ItemDefs;
proc sql noprint;
select OID into :srccol from _svWork.ItemDefs
where name='SCTEST';
quit;

*add record for a new valuelist SCTESTVALS;
proc sql;
insert into _svWork.ValueLists
set OID= "SCTESTVALS",
FK_MetaDataVersion = "$mdv"
/*add record associating the value list SCTESTVALS to the OID for SCTEST ItemDefs record;
insert into _svWork.ItemValueListRefs
set ValueListOID= "SCTESTVALS",
FK_ItemDefs = "$srccol"
/*add records to the ItemDefs data set for each value in the SCTESTVAL value list;
insert into _svWork.ItemDefs
set OID= "VAL001",
Name = "SCTEST",
DataType = "text",
Length = 3,
SASFieldName = "SCTEST",
comment = "Height taken barefoot",
label="Height in inches",
FK_MetaDataVersion = "$mdv"
set OID= "VAL002",
Name = "SCTEST",
DataType = "text",
Length = 4,
SASFieldName = "SCTEST",
comment = "Weight without shoes",
label="Weight in pounds",
FK_MetaDataVersion = "$mdv";
/*add records associating the value list SCTESTVALS to rows in the ItemDefs data set;
insert into _svWork.ValueListItemRefs
set ItemOID= "VAL001",
OrderNumber=1,
Mandatory="Yes",
KeySequence=1,
FK_ValueLists = "SCTESTVALS"
set ItemOID= "VAL002",
OrderNumber=2,
Mandatory="Yes",
KeySequence=2,
FK_ValueLists = "SCTESTVALS";
quit;
/*reassign srcdata to location of _svWork data sets;
data_null__; path=pathname('_svwork'); rc=libname('srcdata');
rc=libname('srcdata',path);
run;
/*create new define.xml file using updated SAS CRT-DDS data sets;
%crtdds_write(_cstCreateDisplayStyleSheet=1);

For the example code, the define.xml file created contains the value-level metadata for
Height and Weight for the SCTEST column in the SC domain.

Note: If you are viewing an electronic version of this document, you can cut and paste
the example code.

Add Annotated CRF Metadata or Value-Level Metadata to the CRT-DDS define.xml File

To add annotated CRF metadata or value-level metadata to the CRT-DDS define.xml file, perform the following steps:

1. Select File ⇒ New ⇒ Job.
An empty job diagram appears on the Diagram page.

2. In the Transformations tree, expand Clinical, and then drag CDISC-SDTM to CRT-DDS onto the diagram.

For detailed information about adding a CDISC-SDTM to CRT-DDS transformation, see “Transforming SDTM Domains in a define.xml File” on page 66.

3. Right-click CDISC-SDTM to CRT-DDS, and then select Properties.

The CDISC-SDTM to CRT-DDS Properties dialog box appears.

For detailed information about the Properties dialog box, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

4. Click the Generation tab.

5. Select the Save work tables to permanent location check box, click Browse that is adjacent to the Location field, and then select a location.

For more information about saving tables, see “Save the Work Tables from a CDISC-SDTM to CRT-DDS Transformation” on page 69.

6. Click OK twice.

7. Click Run.

The define.xml file is generated, and the SAS data sets used to generate the file are included.

8. To add records to the annotatedcrfs, mdvleaf, and mdvleaftitles data sets (for CRF metadata), or valuelists, itemvaluelistrefs, valuelistitemrefs, and itemdefs data sets (for value-level metadata), perform the following steps:

   a. In the Transformations tree, expand Data, and then drag User Written Code transformation onto the diagram.

   b. Right-click User Written, and then select Properties.

      The User Written Properties dialog box appears.

      For more information about the properties dialog box, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.
c. (Optional) Click the **General** tab, and then rename the transformation.

d. Click the **Code** tab.

e. From the **Code generation mode** drop-down list, select **All user written**.

f. In the code editor, enter the code to include annotated CRF metadata or the value-level metadata.

   For example code, see “Overview” on page 72.

g. Click **OK**.

9. Click **Run**, and then review the define.xml file to ensure that the annotated CRF metadata or the value-level metadata is included.

---

**Running the CDISC-SDTM to CRT-DDS Transformation on Saved Data**

**Overview**

The CDISC-SDTM to CRT-DDS transformation operates on saved data so that the information that is stored in the data is added to the CRT-DDS standard.

You create and run a job with a transformation that creates a CRT-DDS define.xml file. The file includes SAS data sets that represent the CRT-DDS data standard model.

*Note:* For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User’s Guide or the SAS Data Integration Studio online Help.

Here is example code that creates a define.xml file:

```sas
%let SASCrtddsTables = %nrquote(\myCDIServer\mydata\crtdds_tables);
%let DefPath = %nrquote(\myCDIServer\mydata\crtdds_tables);
%let DefFile = %nrquote(define.xml);

%cst_setStandardProperties(
   _cstStandard=CDISC-CRTDDS,
   _cstSubType=initialize
);
%let workPath=%sysfunc(pathname(work));
%let _cstSASRefs=work.sasreferences;
%let _cstSASRefsLoc=&workpath;
%let _cstSASRefsName=sasreferences;
%let _cstResultsds=crtdds_results;
%cst_createds(_cstStandard=CST-FRAMEWORK, _cstType=control,
   _cstSubType=reference, _cstOutputDS=work.sasreferences);
proc sql;
insert into work.sasreferences
values ( "CST-FRAMEWORK" "1.2" "messages" "" "messages" "libref" "1" "" ")
values ( "CDISC-CRTDDS" "1.0" "messages" "" "crtmsg" "libref" "2" "" ")
values ( "CDISC-CRTDDS" "1.0" "autocall" "" "auto2" "fileref" "1" "" ")
values ( "CDISC-CRTDDS" "1.0" "sourcedata" "" "srcdata" "libref" "&SASCrtddsTables" "" "")
values ( "CDISC-CRTDDS" "1.0" "externalxml" "xml" "extxml" "fileref" "
```

Running the CDISC-SDTM to CRT-DDS Transformation on Saved Data

---
In the example code, edit SASCrtddsTables to specify the location where the saved data sets exist, and edit DefPath to specify the location to write the resulting define.xml file.

Note: If you are viewing an electronic version of this document, you can cut and paste the example code.

Run the CDISC-SDTM to CRT-DDS Transformation

To run the CDISC-SDTM to CRT-DDS transformation, perform the following steps:

1. Select File ➤ New ➤ Job.
   
   An empty job diagram appears on the Diagram page.

2. In the Transformations tree, expand Data, and then drag User Written Code transformation onto the diagram.

3. Right-click User Written, and then select Properties.
   
   The User Written Properties dialog box appears.

4. Click the Code tab.

5. From the Code generation mode drop-down list, select All user written.

6. In the code editor, enter the code to create the define.xml file.

   For example code, see “Overview” on page 75.

7. Click OK and then click Run.

8. From the Windows Start menu, select Run, and then enter the location where the data sets are located (for example, ```/\myCDIServer\mydata\crtdds_tables```).


   The Location field contains a link to the corresponding transport file. If you click on the link, and the transport file does not exist, you get an error. Search the file for Blank Annotated CRF (blankCRF.pdf#page=3). The define file has valuelist values for height and weight.
Validating a CRT-DDS define.xml File

Overview

The Validate CRT-DDS transformation assesses the validity of the define.xml file. Validity is based on the XML standards for CRT-DDS 1.0.0 as defined by CDISC.

Validity is based on the following criteria:

• The XML is well formed.
• The XML meets the XML schema specification.

Note: For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User’s Guide or the SAS Data Integration Studio online Help.

Register a New Document File

Before you can create a job to validate a CRT-DDS define.xml file, you must register a new document file. The new document file must point to an existing define.xml file in a location that the SAS Workspace Server can access.

For more information about registering a new document file, see the SAS Data Integration Studio: User’s Guide or the SAS Data Integration Studio online Help.

Validate a CRT-DDS define.xml File

To validate a CRT-DDS define.xml file, perform the following steps:

1. Select File ⇒ New ⇒ Job.

   An empty job diagram appears on the Diagram page.

2. In the Transformations tree, expand Clinical, and then drag Validate CRT-DDS onto the diagram.

3. From the Folders tree, drag the define.xml file onto the diagram.
4. Drag the cursor from the define.xml file to the input port of the transformation. This action connects the define.xml file to the transformation.

5. To store CRT-DDS Validation Results work table permanently, perform the following steps:

   Note: By default, the CRT-DDS Validation Results work table is written to a temporary work location.

   a. Right-click the Work Table icon, and then select Properties. The Properties dialog box appears.

   For detailed information about the Properties dialog box, see the SAS Data Integration Studio: User’s Guide or the SAS Data Integration Studio online Help.

   b. Click the Physical Storage tab, select a SAS library for the Location field, and then click OK.

6. Click Run. SAS Data Integration Studio generates the SAS code for validating, and then submits the code to SAS. The CRT-DDS define.xml file is validated, and then the results are written to the CRT-DDS Validation Results work table.

   If there are errors in the CRT-DDS define.xml file, the CRT-DDS Validation Results work table provides a message for each error. An error message includes the line and column number in the define.xml file that generated the error.

7. (Optional) Report on the results of the transformation.

   For information, see “Reporting on the Results of a Transformation” on page 78.

---

**Reporting on the Results of a Transformation**

**Overview**

Use the CDISC-SDTM Compliance transformation to run a report about the compliance of a single domain or multiple domains with a data standard. You can run a report on a domain, multiple domains, or compliance checks.

Note: You must select a data standard, at least one domain, and at least one compliance check.

Use the CDISC-SDTM to CRT-DDS transformation to run a report about the transformation.

Note: You must select at least one domain.

Use the Validate CRT-DDS transformation to run a report about the validity of a CRT-DDS define.xml file.

For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User’s Guide or the SAS Data Integration Studio online Help.
Run a Report

To run a report, perform the following steps:

1. Select File ⇒ New ⇒ Job.
   
   An empty job diagram appears on the Diagram page.

2. In the Transformations tree, expand Clinical, and drag one of the following transformations onto the diagram:
   
   • CDISC-SDTM Compliance
   • CDISC-SDTM to CRT-DDS
   • Validate CRT-DDS

3. In the diagram, double-click the transformation.
   
   The Properties dialog box appears.
   
   For detailed information about the Properties dialog box, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

4. Click the Reports tab.

5. If this is the CDISC-SDTM Compliance transformation, select either Report by Domain or Report by Check, and then select either the Generate Domain Report check box or the Generate Check Report check box.

6. If this is the CDISC-SDTM to CRT-DDS transformation or the Validate CRT-DDS transformation, select the Generate Report check box.

7. Perform one of the following steps:
   
   • Click Browse adjacent to Browse to Folder, and then navigate to a server folder.
   • In the Server Folder field, enter the name of a server folder.
   
   The folder must be on the server and must not be a local folder.

8. Enter a name for the report in the Report File Name field, and then specify the report output format.

9. To limit the number of records to include in the report, enter a number in the Limit # of records to field.
   
   If you leave this field blank, all records are included in the report.

10. Select the panels to include in the report and whether informational messages are included.

11. Click OK.

12. Click Run.
   
   SAS Data Integration Studio generates the SAS code for transforming, and then submits the code to SAS. For the CDISC-SDTM Compliance transformation, the Results and Metrics work tables and reports are generated.

13. Review the report.
Generating Unique Sequence Numbers as an Identifier Variable

Overview

Some of the domains in the CDISC SDTM data standard model require a sequence number as an identifier variable (~SEQ). This sequence number ensures the uniqueness of records for each subject within a data set.

For example, a study might have a series of vital signs collected during each visit. On some days, several readings were taken for heart rate and blood pressure. Before you can load study data into the SDTM VS domain, you need to uniquely identify each of these vital signs for each subject. This means that when you convert the study data, you need to populate each domain and populate the VSSEQ variable.

Use the Subject Sequence Generator transformation to generate a unique sequence number across subjects in a domain. After running the Subject Sequence Generator transformation, another variable is generated that enables you to uniquely identify each vital sign.

Note: For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

Generate Unique Sequence Numbers

To generate unique sequence numbers with the Subject Sequence Generator transformation, perform the following steps:

1. Select File ⇒ New ⇒ Job.
   
   An empty job diagram appears on the Diagram page.

2. From the Folders tree, drag the source table for the domain onto the diagram.

3. In the Transformations tree, expand Clinical, and then drag Subject Sequence Generator onto the diagram.

4. Drag the cursor from the source table to the input port of the transformation.
   
   This action connects the source to the Subject Sequence Generator transformation.

5. In the Transformations tree, expand the Access folder, and then drag Table Loader onto the diagram.

6. Drag the cursor from the output table to the input port of the Table Loader.
   
   This action connects the Subject Sequence Generator_OUTPUT table to the Table Loader.

7. From the Folders tree, drag the SDTM VS domain that you want to populate onto the diagram.

8. Drag the cursor from the output port of the Table Loader to the input port of the SDTM VS domain.
   
   This action connects the Table Loader to the SDTM VS domain (the data target).
9. Right-click **Subject Sequence Generator**, and then select **Properties**.

   The Subject Sequence Generator Properties dialog box appears.

   For detailed information about the Properties dialog box, see the *SAS Data Integration Studio: User's Guide* or the SAS Data Integration Studio online Help.

10. Click the **Options** tab.

11. (Optional) From the **Update Source** drop-down list, select a value.

   - **NO** indicates that the source table is not modified (that is, PROC SORT output is sent to a work table).
   - **YES** indicates that the source table is modified directly by PROC SORT in the code generation.

12. From the **Sequence Key Variable** drop-down list, select the name of the sequence variable in the target domain (–SEQ).

13. In the **Business Keys** list, adjust the order of the available keys.

   This list identifies the keys in the source table. Use these keys to sort the data.

14. From the **Subject Variable** drop-down list, select a variable.

   The subject variable represents the unique subject identifier (USUBJID).

15. Click **OK**.

16. Save and run the job.

   SAS Data Integration Studio generates the SAS code for transforming, and then submits the code to SAS. The –SEQ variable is populated with a sequence number that is unique for each record for each subject.
Part 5

SAS® Integration Adapter for Medidata Rave

Chapter 6
General Administration .................................................. 85

Chapter 7
Study Administration ..................................................... 87
Define a Medidata Rave Server

To define a Medidata Rave server, perform the following steps:

1. Log in to SAS Management Console.
2. Define a new server with the following properties:
   - For the server type, select **Resource Templates** \(\rightarrow\) **Servers** \(\rightarrow\) **Content Servers** \(\rightarrow\) **HTTP Server**.
   - For the base path, define a new base path that is set to the Medidata Rave Web Services, such as /RWS.
   - For the application server type, select **Medidata Rave**.
   - For the authentication domain, specify a new or existing authentication domain. Specify the application protocol as HTTPS, and enter the host name.

For more information about defining a server, see the SAS Management Console online Help.

Enable a SAS Clinical Data Integration User to Log In to Medidata Rave

To enable a SAS Clinical Data Integration user to log in to Medidata Rave, perform the following steps:

1. Log in to SAS Management Console as a user with permission to add server instances and manage users and groups.
2. Add or modify a SAS Clinical Data Integration user account with the following properties:
For the login information, create new login information using the user ID and password to access the Medidata Rave server.

For the authentication domain, specify the same authentication domain that is specified for the Medidata Rave server that you are using.

For more information about adding or modifying a user account, see the SAS Management Console online Help.

Verify That the Medidata Rave Server Has Been Registered Properly

To verify that the Medidata Rave server has been registered properly, perform the following steps:

1. Log in to SAS Clinical Data Integration.
2. Select Tools ⇒ Medidata Rave ⇒ Servers.

   The Registered Rave Servers dialog box appears.

   ![Registered Rave Servers Dialog Box](image)

3. Verify that the **Host**, **Services Path**, and **Rave User ID** (the Medidata Rave user ID for the current SAS Clinical Data Integration user) are correct.

4. Select the row for the Medidata Rave server that you just defined, and then click **Test Connection**.

5. Click **Close**.
Chapter 7
Study Administration

Manage the Connection between a SAS Clinical Data Integration Study and a Medidata Rave Study .................................................. 88
Create a Connection between Studies ............................................. 88
View the Mappings between Studies ............................................. 89
Disconnect a SAS Clinical Data Integration Study from a Medidata Rave Study . 90

Create a SAS Clinical Data Integration Data Table Definition from Medidata Rave Metadata ............................................................. 90

Manage the Medidata Rave Properties of a SAS Clinical Data Integration Study ................................................................. 92
Display the Medidata Rave Properties ............................................. 92
Create a Transformation Log Table for a SAS Clinical Data Integration Study .................. 93
Disassociate a Log Table from a SAS Clinical Data Integration Study ......................... 95
Specify the ODM Archive Location for a SAS Clinical Data Integration Study ........ 95

Managing the Codelist Table in a SAS Clinical Data Integration Study .................. 96
Overview ..................................................................................... 96
Create the Codelist Table for a SAS Clinical Data Integration Study ......................... 96
Reimport a Codelist Table into a SAS Clinical Data Integration Study ....................... 98
Remove the Codelist Table from a SAS Clinical Data Integration Study ............. 98

Review the Medidata Rave Properties of a SAS Clinical Data Integration Data Table Definition ................................................................. 99

Retrieving Medidata Rave Study Data .......................................... 99
Overview ..................................................................................... 99
Notification of Potential Changes ............................................. 100
Set Up the Job to Retrieve Medidata Rave Data .................................. 100
Run the Job, and Then Check the Results ........................................ 101
Ensuring No Raw Data Is Lost during Transformation ........................................ 102

Schedule a Job to Update Study Data from Medidata Rave ......................... 103
Deploy a Job ............................................................................ 103
Create and Schedule a Job Flow .................................................. 103
Manage the Connection between a SAS Clinical Data Integration Study and a Medidata Rave Study

Create a Connection between Studies

Note: You must have Administrator access permissions to the SAS Clinical Data Integration study.

To create a connection between studies, perform the following steps:

1. In the Folders tree, right-click a SAS Clinical Data Integration study root folder, and then select Connect to Medidata Rave.

   The Connect to a Rave Study wizard appears.

2. Select a server from the Registered Rave Servers table.

3. (Optional) Test the connection to the server.

4. Click Next.

   The Rave Studies page appears.
5. Select a study from the Select a Rave Study table, and then click Finish.

6. (Optional) Verify the connection by performing the following steps:
   a. In the Folders tree, right-click the study root folder, and then select Properties. The Properties dialog box appears.
   b. Click the Medidata Rave tab. The Medidata Rave tab contains a table with entries that specify the properties of the Medidata Rave study associated with the SAS Clinical Data Integration study. This information includes the Medidata Rave server information (name, host, base path, and user name) and the Medidata Rave study information (OID, study name, and protocol name).
   c. Click OK.

**View the Mappings between Studies**

To view the mappings between studies, perform the following steps:

1. Select Tools ⇒ Medidata Rave ⇒ Study Mappings. The CDI-Rave Study Mappings dialog box appears.
Each row of the table shows a mapping between a SAS Clinical Data Integration study and a Medidata Rave study on a specific Medidata Rave server.

2. Review the mappings, and then click Close.

**Disconnect a SAS Clinical Data Integration Study from a Medidata Rave Study**

To disconnect a SAS Clinical Data Integration study from a Medidata Rave study, in the Folders tree, right-click a mapped SAS Clinical Data Integration study root folder, and then select Disconnect from Medidata Rave.

*Note:* When you disconnect the studies, the data and objects are not deleted. However, all metadata properties specific to the Medidata Rave connection are deleted from the objects.

**Create a SAS Clinical Data Integration Data Table Definition from Medidata Rave Metadata**

*Note:* You must have Administrator access permissions to the SAS Clinical Data Integration study.

Before you can populate a SAS Clinical Data Integration study with data extracted from a Medidata Rave study, you must create at least one data table definition.

To create a SAS Clinical Data Integration data table definition from Medidata Rave metadata, perform the following steps:

1. In the Folders tree, navigate to the SAS Clinical Data Integration study root folder that is mapped to a Medidata Rave study.
   
   For information, see “Create a Connection between Studies” on page 88.

2. Right-click a SAS Clinical Data Integration study folder, and then select **Import Medidata Rave Table Definitions**.
   
   A progress indicator appears, and then the Import Medidata Rave Table Definitions wizard appears.
All Medidata Rave table definitions for the study and the study version are listed.

Note: The list does not contain table definitions that have no columns.

3. Select one or more tables to import.

4. Click Next.

If you select a Medidata Rave table that has been previously imported into the target folder, a warning appears. You must select a different table. Or, you can exit the wizard, and delete the table from the target folder.

The SAS Library page appears.
5. Using the standard SAS Data Integration Studio library controls, select a library, or create a library definition.

   *Note:* You must have Create access permission to the library that you select.

   For help with using these controls, see the *SAS Data Integration Studio: User's Guide* or the SAS Data Integration Studio online Help.

6. Click **Finish**.

   The tables are imported.

   A SAS Data Integration Studio physical table appears in the folder for each imported Medidata Rave table.

   *Note:* The data table definition has been created, but the data table has no data at this point.

   The name of the SAS Data Integration Studio table is the same as the Medidata Rave table name, except that any characters in the Medidata Rave table name that are not valid for a SAS table name are removed.

---

**See Also**

- “Review the Medidata Rave Properties of a SAS Clinical Data Integration Data Table Definition” on page 99
- “Retrieving Medidata Rave Study Data” on page 99

---

**Manage the Medidata Rave Properties of a SAS Clinical Data Integration Study**

**Display the Medidata Rave Properties**

To display the Medidata Rave properties, perform the following steps:

1. In the **Folders** tree, navigate to the SAS Clinical Data Integration study root folder that is mapped to a Medidata Rave study.

   For information, see “Create a Connection between Studies” on page 88.

2. Right-click the SAS Clinical Data Integration study root folder, and then select **Properties**.

   The Properties dialog box appears.
3. Click the Medidata Rave tab.

4. Modify the properties, and then click OK.

Create a Transformation Log Table for a SAS Clinical Data Integration Study

Note: The primary purpose of the Medidata Rave transformation log table is to debug and provide technical support. Do not alter this table in any way.
To create a Medidata Rave transformation log table for a SAS Clinical Data Integration study, perform the following steps:

1. Display the Medidata Rave properties.
   For information, see “Display the Medidata Rave Properties” on page 92.

2. Click New next to the Transformation Log Table field.
   The New Rave Transformation Log Table wizard appears.

3. Enter a name and optional description for the log table, and then click Next.
   *Note:* The name must be a valid SAS table name.
   The SAS Library page appears.
4. Using the standard SAS Data Integration Studio library controls, select a library, or create a library definition.

   Note: You must have Create access permission to the library that you select.

   For help with using these controls, see the SAS Data Integration Studio: User's Guide or the SAS Data Integration Studio online Help.

5. Click Finish.

   The log table is created directly beneath the study root folder.

---

**Disassociate a Log Table from a SAS Clinical Data Integration Study**

To disassociate a log table from a SAS Clinical Data Integration study, perform the following steps:

1. Display the Medidata Rave properties.

   For information, see “Display the Medidata Rave Properties” on page 92.

2. Click **Remove** next to the **Transformation Log Table** field.

---

**Specify the ODM Archive Location for a SAS Clinical Data Integration Study**

To specify the Operational Data Model (ODM) archive location for a SAS Clinical Data Integration study, perform the following steps:

1. Display the Medidata Rave properties.

   For information, see “Display the Medidata Rave Properties” on page 92.

2. Click **Browse** next to the **ODM Document Archive Folder** field.
3. If you are prompted to log in to the SAS Foundation server, log on so that you can access the SAS Foundation server’s file system.

4. In the ODM Archive Folder dialog box, select a folder to which you have Read and Write access permissions, and then click OK.

---

### Managing the Codelist Table in a SAS Clinical Data Integration Study

#### Overview

When you import a codelist table, SAS Clinical Data Integration imports the codelist table only for the study versions that currently have or that could have (in the future) enrolled subjects. These study versions are considered non-retired versions.

A non-retired version is the desired version set for a specific study environment. This version set contains all study versions which, for that study environment, contain at least one enrolled subject. The most recent version for an environment or site is included in the set for any environment or site in that study. As a result, the most recent version is always available for the forward migration of subject data, even if no subjects are currently enrolled in the most recent version.

Limiting the codelist table in this way ensures that the codelist table does not include data for versions that will never be referenced.

The structure of a SAS data set required to store Medidata Rave codelist table information is the same across all versions. Therefore, the data in a SAS data set for a codelist table can be reimported without data mismatch or metadata mismatch.

#### Create the Codelist Table for a SAS Clinical Data Integration Study

To create the codelist table for a SAS Clinical Data Integration study, perform the following steps:

1. Display the Medidata Rave properties.
   
   For information, see “Display the Medidata Rave Properties” on page 92.

2. Click **New** next to the **Codelist Table** field.
   
   The New Rave Codelist Table wizard appears.
3. Enter a name and optional description for the codelist table, and then click Next.

*Note:* The name must be a valid SAS table name.

The SAS Library page appears.

4. Using the standard SAS Data Integration Studio library controls, select a library, or create a library definition.

*Note:* You must have Create access permission to the library that you select.

For help with using these controls, see the *SAS Data Integration Studio: User's Guide* or the SAS Data Integration Studio online Help.
5. Click Next.

The Codelists page appears.

The table lists the codelist tables that are registered to active Medidata Rave studies to which the SAS Clinical Data Integration study is mapped.

Each row in the table represents one declared codelist table to import. The same codelist table can appear multiple times, once for each study version.

6. (Optional) Click a column heading to reorder the table.

   Note: The information in this table is read-only. You cannot select a row.

7. Click Finish.

   A codelist table with the specified name and description is created directly beneath the study root folder. The codelist table contains the necessary columns and is associated with the SAS library that you selected.

---

**Reimport a Codelist Table into a SAS Clinical Data Integration Study**

To reimport a codelist table into a study, perform the following step:

In the Folders tree, right-click on a codelist table, and then select Import Codelists from Medidata Rave.

---

**Remove the Codelist Table from a SAS Clinical Data Integration Study**

To remove the codelist table from a study, perform the following steps:

1. Display the Medidata Rave properties.

   For information, see “Display the Medidata Rave Properties” on page 92.
The Codelist Table field displays the name of the codelist table associated with the study.

2. Click Remove next to the Codelist Table field.
   Although the codelist table is no longer associated with the study, the codelist table still exists in its original location and retains its data.

---

**Review the Medidata Rave Properties of a SAS Clinical Data Integration Data Table Definition**

To review the Medidata Rave properties of a SAS Clinical Data Integration data table definition, perform the following steps:

1. In the Folders tree, right-click a SAS Clinical Data Integration data table definition that was imported from Medidata Rave, and then select Properties.
   The Properties dialog box appears.

2. Click the Medidata Rave tab, and then review the properties of the Medidata Rave data table definition.

3. Click the Columns tab, right-click on a column, and then select Properties.
   The Properties dialog box appears.

4. Click the Medidata Rave tab, and then review the properties of the Medidata Rave table column.

5. Click OK.

*See Also*

“Create a SAS Clinical Data Integration Data Table Definition from Medidata Rave Metadata” on page 90

---

**Retrieving Medidata Rave Study Data**

**Overview**

After you have created the SAS Clinical Data Integration data table definitions from Medidata Rave metadata, you can populate the SAS Clinical Data Integration study with data extracted from a Medidata Rave study. There are two transformations to retrieve study data from Medidata Rave.

The Extract Medidata Rave Data transformation deletes all Medidata Rave data from the specified data tables in the associated SAS Clinical Data Integration study. Then, the transformation inserts the Medidata Rave study data into the specified data tables. You specify the data tables when you set up the job.

The Update from Medidata Data Rave transformation updates the Medidata Rave study data in the specified data tables with data that has changed since the study data was last retrieved. You specify the data tables when you set up the job.
If you run the Update from Medidata Data Rave transformation on a SAS Clinical Data Integration data table that has not been populated using either of these two transformations, the Update from Medidata Data Rave transformation populates the study just as the Extract Medidata Rave Data transformation does.

**See Also**

“Create a SAS Clinical Data Integration Data Table Definition from Medidata Rave Metadata” on page 90

**Notification of Potential Changes**

When you retrieve study data from Medidata Rave, it is possible that the Medidata Rave table metadata has changed since the data table definition was initially imported. You can choose how to handle a potential change. You can attempt to retrieve the changed data, or you can skip the retrieval of study data for any data table with Medidata Rave table metadata that might have changed. And, you can choose to notify one or more users via e-mail if the transformation detects potential table metadata changes.

The value that you specify for the e-mail address can be a single address, a mailing list, or any other value that is valid for your default e-mail client. The transformation passes the value to the e-mail client without any validation.

*Note:* Notification does not apply to the Medidata Rave Comments table. The structure of the Comments table cannot change across study versions. Therefore, omitting notification prevents unnecessary notifications.

**Set Up the Job to Retrieve Medidata Rave Data**

To set up the job to retrieve Medidata Rave data, perform the following steps:

1. In the **Folders** tree, navigate to a SAS Clinical Data Integration study that is mapped to Medidata Rave, and create a job.

2. In the **Transformations** tree, expand **Clinical**.

3. Drag the **Extract Medidata Rave Data** transformation or the **Update from Medidata Rave Data** transformation onto the job, right-click the transformation, and then select **Properties**.

   The Properties dialog box appears.

4. To select a Medidata Rave data table definition, perform the following steps:

   a. Click the **Tables** tab, select a clinical study, and then select one or more Medidata Rave data table definitions.
Note the selected data table definitions.

*Note:* You can select a Medidata Rave data table definition that contains no data.

b. Click **OK**.

5. To notify users of potential changes to the Medidata Rave table metadata, perform the following steps:

a. Click the **Notifications** tab.

b. Select the **Send Email on Potential Table Metadata Mismatch** check box.

c. In the **Address** field, enter a valid e-mail address or e-mail group.

d. Specify what action to take when a potential mismatch is detected, and then click **OK**.

6. Confirm that there is a green check mark in the lower right corner of the transformation.

   If the green check mark is not there, click on the transformation to display a message that indicates any problems.

---

**Run the Job, and Then Check the Results**

To update data table data from Medidata Rave, perform the following steps:

1. Run the job

   After the job runs, there should be no errors or warnings in the log. If there are, debug them, and run the job again.

2. Save and close the job.
3. Select the transformation log table, and open it.
   There is a record per selected table.

4. Close the transformation log table.

5. For each data table that was selected for processing, perform the following steps:
   a. In the **Folders** tree, right-click a table, and then select **Open**.
      The View Data page appears.
   b. Confirm that the data is correct.
   c. Compare the values in the regular data columns to the _RAW data columns to ensure that no raw data was lost.
      For more information, see “Ensuring No Raw Data Is Lost during Transformation” on page 102.

If the Medidata Rave data tables contain data, the tables selected for processing contain data. If the Medidata Rave data tables do not contain data, the tables selected for processing do not contain data.

*Note:* It is possible that a table will not have data in it if there are no records in the data entry system.

---

**Ensuring No Raw Data Is Lost during Transformation**

When the Medidata Rave Web Services transforms raw data into regular data, some data might fail validation or transformation. Failure during validation or transformation is the result of flawed raw data in Medidata Rave. To ensure that this flawed raw data is not lost during transformation, you can examine in SAS Clinical Data Integration the raw data that was used during the transformation. The ability to examine the raw data helps you prevent submitting null data to a regulatory body when flawed data was entered in Medidata Rave.

The raw data is included in the SAS Clinical Data Integration data set so that you can examine the data and correct it.

For every _RAW data column definition in a Medidata Rave data table definition, there is a corresponding regular data column with the same name, minus the _RAW designation. For example, the IT_SEVERE_RAW data column has a corresponding regular data column named IT_SEVERE.

If the raw data was validated or transformed without error, the values in both the regular data column and the _RAW data column will be identical.

If the raw data was not validated or transformed without error, the value in the regular data column will be empty, and the _RAW data column will contain the raw, invalid value that was in Medidata Rave.
Schedule a Job to Update Study Data from Medidata Rave

Deploy a Job

To deploy a job to update study data from Medidata Rave, perform the following steps:

1. Select the job that will retrieve data from Medidata Rave.
2. In the Folders tree, right-click the job, and then select Scheduling ➔ Deploy.

   The Deploy a job for scheduling dialog box appears.

   ![Deploy a job for scheduling dialog box]

   3. Specify the information for deployment, and then click OK.

Create and Schedule a Job Flow

To create and schedule a job flow, log in to SAS Management Console. Create a flow, and select Platform Process Manager as the scheduling server.

Note: You must log in to SAS Management Console as the same user who created and deployed the job in SAS Clinical Data Integration.

For more information about creating and scheduling a job flow, see the SAS Management Console online Help.
Appendixes

Appendix 1
    Adding Users to the Clinical Administrator Group .......... 107

Appendix 2
    Repairing Clinical Objects .................................. 109

Appendix 3
    SAS Clinical Data Integration Icons ......................... 111

Appendix 4
    Publish to SAS Drug Development ............................... 113
Appendix 1
Adding Users to the Clinical Administrator Group

Overview

Only users in the Clinical Administrators group have permission to see the Clinical Administration tree in SAS Data Integration Studio. Significant features and functions are available through the Clinical Administration tree.

The default security model for SAS Clinical Data Integration is described in the following table. Depending on the level of security required in your organization, users can modify security after installation. Contact your system administrator to determine how security is implemented in your organization.

<table>
<thead>
<tr>
<th>User, Group, or Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Administrators</td>
<td>Default SAS Metadata Server administration group. This group should not be removed from any object in the metadata. Very few users should be added to this group.</td>
</tr>
<tr>
<td>Clinical Administrators</td>
<td>Members of this group can use the Clinical Administration tree and are responsible for managing data standards, studies or submissions, and controlled terminology.</td>
</tr>
<tr>
<td>SASUSERS</td>
<td>All authenticated users belong to this group. These users are responsible for defining content such as creating domains, jobs, and output. Users are assigned to this group by default.</td>
</tr>
</tbody>
</table>

Add a User to the Clinical Administrators User Group

To add a user to the Clinical Administrators user group, perform the following steps:

1. Start SAS Management Console, and then connect to the SAS Metadata Server as an unrestricted user.
   
   For more information, see SAS Management Console: Guide to Users and Permissions.

2. On the Plug-ins tab, expand Environment Management, and then select User Manager.

3. In the right pane, right-click Clinical Administrators, and then select Properties.
   
   The Clinical Administrators Properties dialog box appears.
4. Click the **Groups and Roles** tab.

5. Use the arrows to move one or more users or user groups between the **Available Groups and Roles** list and the **Member of** list.

6. Click **OK**.
Appendix 2
Repairing Clinical Objects

Overview

When a clinical object is damaged and must be repaired, you receive a message. These are the objects that you might need to repair:

- data standard
- domain template
- column group
- controlled terminology package
- study or submission
- domain or domain column

Note: A clinical object can be damaged when you export data standards or controlled terminology packages using Export \(\Rightarrow\) SAS Package or Export \(\Rightarrow\) Metadata in SAS Data Integration Studio. These methods are not recommended. Instead, create the data standard or controlled terminology package using SAS Clinical Data Integration.

Repair a Domain Template, Column Group, or Controlled Terminology Package

To repair a domain template, column group, or controlled terminology package, perform the following steps:

1. In the Folders tree or in the Clinical Administration tree, navigate to a domain template, column group, or controlled terminology package.
2. Right-click the item, and then select Repair.
   
   A message appears when the repair is completed.
3. If no problems are found, click OK.
4. To review the analysis report for a domain template or column group, click Details.
   
   If you choose to repair the problems, a progress indicator appears. A message appears when the repair is completed.
Repair a Copy of a Data Standard, Study, or Submission

To repair a copy of a data standard, study, or submission, perform the following steps:

1. In the Folders tree, navigate to a data standard, study, or submission.
2. Right-click the item, and then select Repair Copy.
   The Repair Copy wizard appears.
3. In the New Name field, accept the default name, or enter a new name.
4. Click Next.
5. Review the summary, and then click Finish.
   Repairs are made. The Folders tree or the Clinical Administration tree is updated with new information.

Repair a Domain or Domain Column

To repair a domain or domain column, perform the following steps:

1. In the Folders tree or in the Clinical Administration tree, navigate to a domain or a domain column.
2. Right-click the domain or domain column, and then select Repair.
3. If no problems are found, click OK.
4. To review the analysis report, click Details.
   If you choose to repair the problems, a progress indicator appears. A message appears when the repair is completed.
Appendix 3
SAS Clinical Data Integration Icons

The Folders Tree

The following icons represent objects in the Folders tree that are provided by SAS Clinical Data Integration. All other icons are standard SAS Data Integration icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder Icon]</td>
<td>Root folder of a submission</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Root folder of a study</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>SAS Clinical Data Integration study that is connected to a Medidata Rave study</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Clinical domain</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Submission</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Study</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Medidata Rave table</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Medidata Rave codelist</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Medidata Rave log</td>
</tr>
</tbody>
</table>

The Clinical Administration Tree

The following icons represent objects in the Clinical Administration tree that are provided by SAS Clinical Data Integration. All other icons are standard SAS Data Integration icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Study</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Submission</td>
</tr>
</tbody>
</table>
Appendix 4
Publish to SAS Drug Development

Overview of Publish to SAS Drug Development Feature .......................... 114
Requirements ................................................................. 114
Installation and Configuration ............................................. 114
  Install the Publish to SAS Drug Development Feature .................... 114
  Define a SAS Drug Development Server in SAS Management Console .... 115
General Steps ................................................................. 116
  Overview of the General Steps ............................................. 116
  Tasks Performed by the Publish to SAS Drug Development Feature in SAS Clinical Data Integration ................................. 116
  Tasks Performed by You in the Publish to SAS Drug Development Feature ............................ 116
  Tasks Performed by You in SAS Drug Development ......................... 117
SAS Drug Development Servers .................................................. 117
  SAS Management Console ................................................ 117
  Login Information for a SAS Drug Development Server .................. 117
Jobs .............................................................................. 117
  Incomplete Jobs ............................................................. 117
  User-Written Code .......................................................... 118
  Collection of Run-Time Statistics ........................................... 118
  LIBNAME Statement That References Multiple Locations ................. 118
  Generate a Report ........................................................... 118
  Republish a Job ................................................................ 118
Transformations .................................................................... 118
  Supported Transformations ................................................. 118
  Compliance and Validation Transformations ................................ 119
  Subject Sequence Generator Transformation ................................ 119
  Medidata Rave Transformations ............................................ 119
Process Names ...................................................................... 119
Paths ................................................................................. 120
  Choosing Not to Create a Process Parameter from a Path .................. 120
  Validation ................................................................. 120
  Absolute Paths and Relative Paths ....................................... 121
Input and Output Folders ......................................................... 122
WebDAV Options .................................................................. 122
Refining Process Parameters in the SAS Drug Development Process Editor ........................................ 122
  Overview of Refining Process Parameters .................................. 122
  Controls ................................................................. 122
Overview of Publish to SAS Drug Development Feature

The Publish to SAS Drug Development feature enables you to transfer a SAS Clinical Data Integration job to SAS Drug Development. In SAS Drug Development, the job becomes a process.

Requirements

To use the Publish to SAS Drug Development feature, the following requirements must be met:

SAS Drug Development Server
- SAS Drug Development 3.5 or later
- SAS Drug Development remote API 3.5.60 or later
- The capability to deploy the remote API over the Web through the HTTPS protocol
- If transformations that are specific to SAS Clinical Data Integration are used, the SAS Clinical Standards Toolkit must be installed and configured in the SAS Drug Development execution environment

Client
- SAS Clinical Data Integration 2.3

Installation and Configuration

Install the Publish to SAS Drug Development Feature

To install the Publish to SAS Drug Development feature, perform the following steps:

1. Ensure that neither SAS Clinical Data Integration nor SAS Management Console is running.
2. Download the PublishToSDD.zip file.

The ZIP file is located at http://support.sas.com/demosdownloads/setupcat.jsp?cat=SAS+Clinical+Data+Integration+Studio.
3. Extract the contents of the PublishToSDD.zip file to an empty folder.

   Note: Do not extract the contents to the SAS installation folder or to a system folder.

4. Perform one of the following steps:
   a. If SAS Data Integration Studio is installed in the default location (which is `C:\Program Files\SASHome`), run setup.bat.
   b. If SAS Data Integration Studio is not installed in the default location (which is `C:\Program Files\SASHome`), run setup.bat from a command line, and specify the location of SAS Data Integration Studio.

      For example:
      ```bash
      setup "d:\Program Files\SASHome"
      ```

5. Create a copy of `C:\Program Files\SASHome\SASDataIntegrationStudio\4.3\picklist`.

   This copy is a backup so that you can restore the original picklist file, if needed.

   Note: If you installed SAS to a location other than the default location, substitute that location for `C:\Program Files\SASHome`.

6. Edit the original picklist file in an editor such as Microsoft WordPad by adding the following lines under the first line (the `Picklist-Version` line):

   ```plaintext
   name=sas.sdd.remoteapi
   version=3.5.89
   ```

   **Tip** Add a blank line above and below these new lines. Although they are not required, blank lines make the text easier to read.

7. Save the original picklist file.

8. To verify that the Publish to SAS Drug Development feature is installed correctly, perform the following steps:
   a. Log in to SAS Clinical Data Integration, click the **Folders** tab, and then navigate to a job.
   b. Right-click the job, and confirm that two additional menu items appear on the pop-up menu: **Publish to SAS Drug Development** and **Open in SAS Drug Development**.

---

**Define a SAS Drug Development Server in SAS Management Console**

To define a SAS Drug Development server in SAS Management Console, perform the following steps:


2. Define a new server with the following properties:
   - For the server type, select **Resource Templates** ⇒ **Servers** ⇒ **Content Servers** ⇒ **HTTP Server**.
   - For the base path, accept the default value of `/.

      Note: The base path value is not used, but it must be supplied.
   - For the application server type, select **SAS Drug Development**.
For the authentication domain, specify a new or existing authentication domain. Specify the application protocol as HTTPS.

For the host name, enter the full name of the server as it appears in the SAS Drug Development Web address for your organization (for example, sddserver.mycompany.com:443).

Note: The default port number is 443. The port number might be different in your organization.

To enable a user to automatically log in to SAS Drug Development when publishing a job, register the user’s user name and password to a new account.

For more information about defining a server, see the SAS Management Console online Help.

General Steps

Overview of the General Steps

To use a SAS Clinical Data Integration job in SAS Drug Development, paths that are specified in the job must be converted to parameters in a SAS Drug Development process. This conversion is needed because paths that are valid in a SAS Clinical Data Integration job might not be valid in the SAS Drug Development Process Editor execution environment.

The following general steps describe the process of publishing and refining a SAS Clinical Data Integration job to use in SAS Drug Development.

Tasks Performed by the Publish to SAS Drug Development Feature in SAS Clinical Data Integration

1. Identify the paths in the SAS Clinical Data Integration job.
   
   For information about how user-written code is handled, see “User-Written Code” on page 118.

2. Create SAS Drug Development process parameters from the paths identified in step 1.

3. Copy the job to SAS Drug Development.

Tasks Performed by You in the Publish to SAS Drug Development Feature

1. Select the SAS Drug Development server to which to publish the job.

2. Select the location in SAS Drug Development in which to store the process. (The process is created from the job.)

3. Specify the input and output folders to use and the locations of the folders in SAS Drug Development.

4. Specify the WebDAV options, if needed.
Tasks Performed by You in SAS Drug Development

1. In the repository, create the output folders that are required by the process.
   
   Note: You must have the necessary access permissions to the SAS Drug Development repository.

2. In the repository, move or copy the input files into the locations that are required by the process.

3. In the SAS Drug Development Process Editor, verify and refine the process parameters.
   
   For more information, see “Refining Process Parameters in the SAS Drug Development Process Editor” on page 122.

SAS Drug Development Servers

SAS Management Console

You define or remove a SAS Drug Development server in SAS Management Console. For information about managing servers, see the SAS Management Console online Help.

Note: After a SAS Drug Development server is defined or removed in SAS Management Console, the change is not available to open sessions of SAS Clinical Data Integration. Each open session of SAS Clinical Data Integration must be stopped and restarted to see the change.

Login Information for a SAS Drug Development Server

You must log in to a SAS Drug Development server. The login information is retained during the SAS Clinical Data Integration session.

Note: You can connect to multiple SAS Drug Development servers during a single publishing session. However, you can publish to only one SAS Drug Development server at a time. And, the publishing settings that you set apply to a selected SAS Drug Development server, not to all SAS Drug Development servers to which you are connected.

When you close the Publish to SAS Drug Development dialog box, the publishing session ends. All connections to SAS Drug Development servers are closed. The login information is retained if you publish to SAS Drug Development again during the current SAS Clinical Data Integration session.

Jobs

Incomplete Jobs

You can publish a job that does not contain all of the information that the transformation needs, but you are notified of the lack of information during the publish. You have the
choice to publish the incomplete job or not. If you choose to publish the job, you must provide the missing information in SAS Drug Development.

**User-Written Code**

You can publish a job that contains user-written code at the job level or at the transformation level.

*Note:* For the Publish to SAS Drug Development feature to identify the paths specified in user-written code, the user-written code must be SAS code that is syntactically correct. SAS code that is not syntactically correct might cause the Publish to SAS Drug Development feature to fail to identify the paths.

**Collection of Run-Time Statistics**

You can publish a SAS Clinical Data Integration job that collects run-time statistics, but it will not run in SAS Drug Development. You are notified of the conflict during the publish. You have the choice to publish the job or not.

**LIBNAME Statement That References Multiple Locations**

You can publish a job that contains a LIBNAME statement that references multiple locations. Each referenced location becomes a process parameter.

**Generate a Report**

You can publish a job that contains a SAS Clinical Data Integration transformation that generates a report.

**Republish a Job**

You can republish a job to SAS Drug Development. In this case, the process in SAS Drug Development is overwritten. Or, if versioning is enabled for the process, a new version is created.

*Note:* If the process is checked out by another user, you are notified. The job cannot be republished until the process is checked in.

---

**Transformations**

**Supported Transformations**

You can publish a job that contains any SAS Data Integration Studio transformation or SAS Clinical Data Integration transformation. Certain transformations are addressed in this section.
**Compliance and Validation Transformations**

You can publish a job that contains the CDISC-SDTM to CRT-DDS compliance transformation, the CDISC-SDTM Compliance transformation, or the Validate CRT-DDS transformation. The transformation must be valid.

After you publish a job that contains the CDISC-SDTM to CRT-DDS compliance transformation or the Validate CRT-DDS transformation, you must modify the process’s source code. Remove the following line from the process’s source code using the SAS Drug Development Process Editor:

```sas
VALUES ("%nrbquote(CDISC-CRTDDS)", "%nrbquote(1.0)",
        "%nrbquote(properties)", "%nrbquote(validation)", %nrbquote(inprop)",
        "%nrbquote(fileref)", "," , 1, "%nrbquote(validation.properties)", ""
```

**Subject Sequence Generator Transformation**

You can publish a job that contains the Subject Sequence Generator transformation.

If you select the option to update the source table in the transformation’s properties, you must select **Input and Output** as the **Folder Type** in the **Paths** table in the Publish to SAS Drug Development dialog box for the folder that contains the source table.

**Medidata Rave Transformations**

You can publish a job that contains the Extract Medidata Rave Data transformation or the Update from Medidata Rave Data transformation.

*Note:* SAS Drug Development might need to be configured to permit access to the Medidata Rave server.

**Process Names**

When you publish a job for the first time, the name of the SAS Clinical Data Integration job is used to generate a default SAS Drug Development process name. The extension .sas is appended to the process name.

For example, the SAS Clinical Data Integration job named TestJob generates the default SAS Drug Development process named TestJob.sas.

You can change the process name.

Once the process name is specified, it must be valid. If a process name is generated from the job name, it is validated when it is generated. If you create or change a process name, it is validated after you complete the **Target Filename** field.

The following table lists the invalid process name conditions and how they are resolved.

<table>
<thead>
<tr>
<th>Invalid Process Name Condition</th>
<th>Resolution to Create Valid Process Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starts or ends with a blank</td>
<td>Leading and trailing blanks are removed.</td>
</tr>
</tbody>
</table>
### Invalid Process Name Condition | Resolution to Create Valid Process Name
---|---
Contains two or more consecutive blanks | Two or more consecutive blanks are changed to a single blank.
Contains characters (such as & or *) other than the following characters:
- alphanumeric characters
- single blanks that do not occur at the start or end of the filename
- ! # $ ; = @ ` _ ~ ^ ' . { } [ ] ( ) | Disallowed characters are removed.
Is empty | No change is made. The addition of the extension .sas creates a valid process name.
Is longer than 128 characters | The filename is truncated to 128 characters.

*Note: After all of the changes are made, if the process name exceeds 128 characters and does not end with .sas, the process name is truncated to the first 124 characters, and .sas is appended.*

### Paths

#### Choosing Not to Create a Process Parameter from a Path

By default, a process parameter is created from every path in the SAS Clinical Data Integration job. You can choose not to create a process parameter from a path by clearing the **Use** check box for the path.

The following figure shows the **Use** check boxes in the Publish to SAS Drug Development dialog box.

**Figure A4.1** The **Use** Check Boxes in the Publish to SAS Drug Development Dialog Box

<table>
<thead>
<tr>
<th>Paths:</th>
<th>Name</th>
<th>Local Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEBDAVFILENAME1</td>
<td>filename writeit1 webdav &quot;http...</td>
<td></td>
</tr>
<tr>
<td>WEBDAVFILENAME2</td>
<td>filename writeit2 webdav &quot;http...</td>
<td></td>
</tr>
<tr>
<td>WEBDAVFILENAME3</td>
<td>filename writeit3 webdav &quot;http...</td>
<td></td>
</tr>
</tbody>
</table>

For example, you might choose not to create a process parameter from a path so that you can use the identical path in your development environment and in your production environment.

#### Validation

When you specify a target folder path, you can either select a path in the Choose a SAS Drug Development Folder dialog box, or you can enter a path. If you enter a path, it is validated after you complete the field.
The following table lists the invalid path conditions in a path that you enter and how they are resolved. The table also describes how the invalid conditions are resolved.

### Table A4.2 Invalid Path Conditions in a Path That You Enter and How They Are Resolved

<table>
<thead>
<tr>
<th>Invalid Path Condition in Path That You Enter</th>
<th>Resolution to Create Valid Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starts or ends with a blank</td>
<td>Leading and trailing blanks are removed.</td>
</tr>
<tr>
<td>Contains two or more consecutive blanks</td>
<td>Two or more consecutive blanks are changed to a single blank.</td>
</tr>
<tr>
<td>Contains characters (such as &amp; or *) other than the following characters:</td>
<td>Disallowed characters are removed.</td>
</tr>
<tr>
<td>• alphanumeric characters</td>
<td></td>
</tr>
<tr>
<td>• single blanks that do not occur at the start or end of the filename</td>
<td></td>
</tr>
<tr>
<td>• ! # $ ; = @ _ ` ~ ^ - . { } [ ] ( )</td>
<td></td>
</tr>
<tr>
<td>Contains a backslash ()</td>
<td>Backslashes are replaced with slashes (/).</td>
</tr>
<tr>
<td>Note: The Publish to SAS Drug Development feature assumes that a backslash indicates the path separator. In SAS Drug Development, a slash indicates a path separator.</td>
<td></td>
</tr>
<tr>
<td>Does not start with a slash</td>
<td>A single slash is prepended.</td>
</tr>
<tr>
<td>Contains two or more consecutive slashes</td>
<td>Two or more consecutive slashes are converted to a single slash.</td>
</tr>
<tr>
<td>Contains only a period (.) or two periods (..) between slashes</td>
<td>The periods between the slashes and the slashes are removed.</td>
</tr>
<tr>
<td>Is longer than 128 characters</td>
<td>The filename is truncated to 128 characters.</td>
</tr>
<tr>
<td>Note: After all of the changes are made, if the filename exceeds 128 characters and does not end with .sas, the filename is truncated to the first 124 characters, and .sas is appended.</td>
<td></td>
</tr>
</tbody>
</table>

### Absolute Paths and Relative Paths

The path to a job in SAS Drug Development is always absolute.

The path to an input folder or output folder can be absolute or relative.

In general, if the input folder or output folder is shared by multiple processes, use an absolute path. If the input folder or output folder is specific to a SAS Drug Development process and its location, use a relative path.

### See Also

“Specify the Path Information” on page 126
Input and Output Folders

A folder that is used by a job can contain input files, output files, or both. You must specify the type of files in the folder. If you specify the wrong type of folder, an error message is displayed when the SAS Drug Development process is run.

WebDAV Options

Options in a SAS Clinical Data Integration job that are specific to a LIBNAME statement or a FILENAME statement that references a WebDAV location are removed when the job is published to SAS Drug Development. Other options are not removed.

You can view each WebDAV location reference as it appears in the SAS Clinical Data Integration job. You can view how the LIBNAME or FILENAME statement will change when it is published to SAS Drug Development. This information is shown in the WebDAV Options dialog box.

Changes that you make to the options are retained during the current SAS Clinical Data Integration session.

See Also

“Specify the WebDAV Options” on page 127

Refining Process Parameters in the SAS Drug Development Process Editor

Overview of Refining Process Parameters

Process parameters that you specify in the Publish to SAS Drug Development feature are the starting point for using a SAS Clinical Data Integration job in SAS Drug Development. In most cases, you will need to refine the process parameters in the SAS Drug Development Process Editor after the job is published.

Controls

In the Publish to SAS Drug Development feature, the controls that you use to specify information about process parameters are similar to the controls in the SAS Drug Development Process Editor.

The following figure shows the controls in the Publish to SAS Drug Development feature. These controls correspond to the controls in the SAS Drug Development Process
Editor. You specify information about each process parameter in a job, not about the job itself.

**Figure A4.2** Corresponding Controls

![Image of the Publish to SAS Drug Development feature](image)

### Control Which Files to Get for a Process Parameter

By default, the Publish to SAS Drug Development feature specifies the process parameters so that all of the files located in the process parameter paths are retrieved before the process runs in SAS Drug Development. This action ensures that required files are available to the process.

However, the process might not actually require all of these files. A process parameter path that specifies a location that is shared with multiple processes probably contains files that are not required by the process. To avoid retrieving unnecessary files and increasing the run time of a process, change the default selection.
In the SAS Drug Development Process Editor, select Get selected files instead of Get all files, which is the default. The following figure shows the selections.

**Figure A4.3 Change Default Selection to Get Only the Files Required by a Process**

Then, select the files required by the process.

*See Also*

“Open a Job in the SAS Drug Development Process Editor” on page 127

---

**Publish a SAS Clinical Data Integration Job to SAS Drug Development**

To publish a SAS Clinical Data Integration job to SAS Drug Development, perform the following steps:

*Select a Job*

1. Start SAS Clinical Data Integration.
2. On the Folders tab or on the Inventory tab, navigate to a job.
3. Right-click the job, and select Publish to SAS Drug Development.

The Publish to SAS Drug Development dialog box appears.
Note: The dialog box title indicates that there is no connection to a SAS Drug Development server: (Not Connected). Also, the WebDAV Options button is available only when a job contains at least one LIBNAME statement or FILENAME statement that references a WebDAV location.

Select a SAS Drug Development Server

1. From the Server drop-down list, select the SAS Drug Development server to which to publish the job, and click Connect.

   The SAS Drug Development Login dialog box appears.

   Note: If you have previously connected to the SAS Drug Development server, or if your credentials for SAS Drug Development have been specified in SAS Management Console, you are not prompted to log in. For more information, see “Login Information for a SAS Drug Development Server” on page 117.

2. Enter your user name and password, and click OK.

   Regardless of the method used to log in, the SAS Drug Development server connection is confirmed.
Specify the Job Information

1. (Optional) In the Job table, enter the filename in the Target Filename column.
   For more information, see “Process Names” on page 119.

2. To specify the location in SAS Drug Development in which to store the job, perform one of the following steps:
   - Enter an absolute path in the Target Folder column.
     For more information, see “Paths” on page 120.
   - Select the job from the Job Name column, and click Browse. In the Choose a SAS Drug Development Folder dialog box, navigate to a folder, and click OK.
     
     **Tip**: To select the location that is in the Target Folder column, click Select Initial Folder.

**Note**: The speed at which you can browse the SAS Drug Development repository depends on the size of the repository and your network connection.

Specify the Path Information

**Note**: All of the following steps are optional.

1. To create a process parameter from a path that is listed in the Paths table, select the check box in the Use column beside the appropriate path.

2. To specify the target folder in SAS Drug Development, perform one of the following steps:
   - Enter the folder name in the Target Folder column.
     For more information about how a default folder name is created, see “Process Names” on page 119.
   - Select the path from the Name column, and click Select Target Folder. In the Choose a SAS Drug Development Folder dialog box, navigate to a folder, and click OK.
     
     **Tip**: To select the location that is in the Target Folder column, click Select Initial Folder.

**Note**: To specify that the location is relative to the location of the process in SAS Drug Development, select As relative path.

**Note**: The speed at which you can browse the SAS Drug Development repository depends on the size of the repository and your network connection.

3. In the Path Type column and the Folder Type column, select values for the type of path and folder.
   For more information, see “Absolute Paths and Relative Paths” on page 121 and “Input and Output Folders” on page 122.

4. To prompt the SAS Drug Development user for a parameter value, select the check box in the Enabled column.

5. Repeat steps 1 through 4 for each path in the Paths table.
Specify the WebDAV Options

Note: The WebDAV Options button is available only when a job contains at least one LIBNAME statement or FILENAME statement that references a WebDAV location.

1. In the Paths table, click in the Name column to select a path.
2. Click WebDAV Options.

The WebDAV Options dialog box appears.

3. Review the original path statement in the Original statement field.
4. To modify options that are not specific to WebDAV, perform the following steps:
   a. Select the Modify options check box.
   b. In the Options field, enter the options.
5. Review the modified path statement in the Target statement field.
6. Click OK.
7. Repeat steps 1 through 6 for each path in the Paths table.

Publish the Job

1. In the Publish to SAS Drug Development dialog box, click Publish.

You are asked whether you want to open the job in the SAS Drug Development Process Editor.
2. If you want to refine the process, click Yes.

Open a Job in the SAS Drug Development Process Editor

Note: To access the SAS Drug Development Process Editor, you must have the system policy User can access the Process Editor application.

To open a job in the SAS Drug Development Process Editor from within SAS Clinical Data Integration, perform the following steps:
1. Log in to SAS Clinical Data Integration.
2. On the Folders tab or on the Inventory tab, navigate to a job that has been published to SAS Drug Development.
3. Right-click the job, and select Open in SAS Drug Development.
The Open in SAS Drug Development Process Editor dialog box appears.

4. Select the SAS Drug Development server, and click **Open**.
   
   If you are not logged in to SAS Drug Development, the Application Authentication dialog box appears.

   ![Application Authentication dialog box](image)

   The SAS Clinical Data Integration job is converted to a SAS Drug Development process. The process is opened in the SAS Drug Development Process Editor.
A
annotated CRF metadata adding to define.xml file 72

C
CDISC SDTM data standard reporting on compliance 78 validating domains for compliance with 63
CDISC SDTM target files converting study data into 63 CDISC-SDTM Compliance transformation 78 CDISC-SDTM to CRT-DDS transformation 66 including computational algorithm and codelist metadata in define.xml file 71 reporting on 78 running on saved data 75 saving data from 69 Clinical Administration tree permissions for 107 Clinical Administrators group adding users to 107 clinical domains validating 21 clinical objects repairing 109 clinical programmers and data managers 4 clinical properties editing 71 codelist metadata including in define.xml file 71 codelist tables create for a study 96 re-import 98 remove from a study 98 column groups 54 repair 109 columns add to domains 61 edit domain column properties 61 repair domain columns 110 common property models 14 compliance assessing CDISC SDTM compliance 63 reporting on 78 compliance checks change the status of 28 create 24 delete 29 edit 24 managing 21 reporting on 78 status of 21 viewing 23 computational algorithm metadata including in define.xml file 71 conditional column groups 54 controlled terminology 16 See also terminology packages import from SAS Clinical Standards Toolkit 17 controlled terminology packages repair 109 CRT-DDS data standard adding saved data to 75 CRT-DDS define.xml file See define.xml file CRT-DDS standard format transforming CDISC-SDTM format to 66 custom domains automatically create key 62 create 56 create from existing domain 58 creating 54 creating from existing domains 55
promoting 29

D
data loading into domains 63
saving from CDISC-SDTM to CRT-DDS transformation 69
data standards assessing CDISC SDTM compliance 63
customizing domain templates 16
customizing properties 14
defining studies with 10
importing metadata 10
managing compliance checks 21
promoting custom domains to repair copies of 110
data standards administration 9
data standards administrators 4
default folders 38
add 39
default libraries 40
add 41
delete 42
view and modify properties 41
declare XML file 66
adding annotated CRF and value-level metadata to 72
adding value-level metadata to 72
including computational algorithm and codelist metadata in 71
reporting on validity of 78
validating 77
domain columns repair 110
domain properties edit 60
domain templates creating standard domains 54
customizing, for data standards 16
repair 109
domains add columns to 61
analyzing usage information 29
creating custom domains 54
creating custom domains from existing domains 55
creating standard domains 54
edit column properties 61
edit properties 60
loading data into 63
monitoring status of 47
promoting custom domains 29
refreshing metadata in standard domain 48
repairing 110
reporting on compliance 78
transforming from CDISC SDTM standard format to CRT-DDS standard format 66
validating clinical domains 21
validating for compliance with CDISC SDTM 63

F
collection structure 38
folders, default
See default folders

I
icons
Medidata Rave 111
SAS Clinical Data Integration 111

J
jobs
schedule to update study data from Medidata Rave 103

L
libraries 54
See also default libraries
librefs
consistent use of 40
loading data into domains 63

M
Medidata Rave icons 111
Medidata Rave properties
SAS Clinical Data Integration data table definition 99
Medidata Rave server define 85
test 86
Medidata Rave studies
connect SAS Clinical Data Integration study 88
disconnect SAS Clinical Data Integration study 90
view mapping to SAS Clinical Data Integration study 89
Medidata Rave table metadata notification of potential changes 100
Medidata Rave transformation log tables create 93
disassociate from a study 95
metadata
adding annotated CRF and value-level metadata to define.xml file 72
adding value-level metadata to define.xml file 72
importing, for data standards 10
including computational algorithm and codelist metadata in define.xml file 71
metadata folder structure 38

O
ownership 4

P
permissions
for Clinical Administration tree 107
properties
customizing data standard properties 14
edit domain column properties 61
edit study or submission 45
editing clinical properties 71
editing domain properties 60
view and modify default folder properties 39
view and modify default library properties 41

R
reports 33
CDISC-SDTM to CRT-DDS transformation 78
compliance 78
run and save 33
validity of define.xml file 78

S
SAS Clinical Data Integration 3
workflow 4
SAS Clinical Data Integration data table definitions
create for Medidata Rave metadata 90
Medidata Rave properties 99
SAS Clinical Data Integration icons 111
SAS Clinical Data Integration studies
connect Medidata Rave study 88
disconnect Medidata Rave study 90
view mapping to Medidata Rave study 89
SAS Clinical Standards Toolkit
import controlled terminology from 17
saved data
running CDISC-SDTM to CRT-DDS transformation on 75
SDTM domains
transforming into define.xml file 66
security model 107
sequence numbers 80
standard domains
create 55
creating 54
refreshing 48
status
change, for compliance checks 28
of compliance checks 21
structural consistency of studies 38
studies
add default folders 39
consistent use of librefs 40
create 44
creating 42
defining with data standard 10
delete 46
edit properties 45
maintaining structural consistency 38
managing 37
monitoring domain status 47
repair copies of 110
study data
schedule a job to update 103
study default folders
delete 40
view and modify properties 39
Subject Sequence Generator
transformation 80
submission default folders
delete 40
view and modify properties 39
submissions
add default folders 39
consistent use of librefs 40
create 44
creating 42
delete 46
edit properties 45
managing 37
monitoring domain status 47
repair copies of 110

T
target files
converting study data into 63
terminology
See controlled terminology
terminology packages 16
create 18
edit 19
importing 16
repair 109
terminology tables 16
trial manager 4

V
Validate CRT-DDS transformation 77, 78
value-level metadata
  adding to define.xml file 72

W
workflow owners 4
workflows 4

U
unique records 80
usage information
  analyzing 29
users
  adding to Clinical Administrators group 107